ACH ALE

an Alkami Solution Team :

SERVICES: PRO-TECH/PRO-TECH CR

Finastra Client User Guide




This document is intended to provide the reader with information related to PRO-TECH/PRO-TECH
CR. These features are differentiated in this document as follows:

» Standard features will appear in regular font, as shown here.

» Features available with PRO-TECH CR module will appear in green, italic font, as
shown here.

If you see a feature within this documentation that is not currently enabled for your organization, contact
us at [FI INSERT PHONE NUMBER] for assistance.

NOTICE:

This document contains confidential proprietary information published by ACH Alert, an Alkami
Solutions Team. The information in this document is intended solely for the use of ACH Alert’s
employees and clients.

All rights reserved. This information may not be disclosed to any third party without the express
written permission of ACH Alert, an Alkami Solutions Team.

NOTE:

» All screenshots used in this User Guide were obtained while using PRO-TECH/PRO-TECH
CR in the Chrome browser. If a Client user utilizes PRO-TECH/PRO-TECH CR in a different
browser, certain screens may display differently than what is seen in this guide because
of the browser’s particular configuration. However, even though screens may appear
slightly different, the functionality will remain the same across all browsers.
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A. WELCOME TO PRO-TECH/PRO-TECH CR!
. SERVICE OVERVIEW

PRO-TECH and PRO-TECH CR are two separate ACH positive pay services designed to empower
account holders (“Clients”) with the ability to prevent financial loss due to unauthorized incoming ACH debit
(PRO-TECH) and credit (PRO-TECH CR) transactions. Certain types of fraudulent ACH debit and credit
transactions must be returned to the originating financial institution by the opening of the 2" business day
following the settlement date. This means businesses must identify these transactions same day and return
any unauthorized transactions immediately to prevent financial loss.

The FI must have PRO-TECH in order to get PRO-TECH CR. The PRO-TECH module can be used
singularly, but PRO-TECH CR cannot be utilized without also having the PRO-TECH module.

This guide is intended to provide information to Clients to aid in using this service in a manner that suits their
specific needs.

Both the PRO-TECH and PRO-TECH CR modules are highly configurable. This guide will outline all PRO-
TECH and PRO-TECH CR functionality. A list of PRO-TECH and PRO-TECH CR Features are set forth

below.
Feature Name PRO-TECH or
Description PRO-TECH CR Standard Optional
Allows Clients to identify companies that
. are allowed to debit/credit an account or
Approved List accounts and set parameters to control Zall /
the debit activity.
Allows Clients to identify companies that
Blocked List | are NOT allowed to debit/credit an Both / /
account or accounts.
e as Establishes who should be alerted, how
Nogf:IT:;lon they should be alerted and the Both /
conditions that should prompt an alert.
If the user has been granted the Change
Change Status user privilege and the transaction
Transaction | is eligible for a decision, the Client will Both /
Status be able to make pay/return decisions on
ACH Debits or Credits.
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Feature Name PRO-TECH or

Description PRO-TECH CR Standard Optional
Writt If required by the financial institution,
State%:nnt of this form will be completed to return a /
Unauthorized transaction, by selecting a reason and PRO-TECH only

Debit (WSUD) providi'ng an electronic signature
authorizing the return.

It is important to note that some FI’s
No Written may choose to require business account

Statement of | clients to make all pay/return decisions
Authorized same day and waive the requirement to PRO-TECH only /
Debit present a Written Statement. In that
case, this feature will not be available.
Allows a user to view data on the following
features:
Reports e Notification Rules Both /

e Approved List
e Block List

The first section of this guide will cover features of PRO-TECH and PRO-TECH CR that are essentially the
same in both modules. The second section will outline PRO-TECH specific functionality, and the third section
will outline PRO-TECH CR functionality.

Accounts enrolled in these services are assigned a default setting of System-Pay or System-Return. If a
decision is not made by the end of day cut-off time, the default setting will apply.

Three levels of notification and two alert types are supported, as well as customized notification rules.
Approved and blocked lists are available to automatically override the system default settings to automatically
pay or return transactions when they are received from companies identified on those lists. The approved and
blocked lists are designed to minimize unnecessary alerts and action when transactions are within pre-
approved parameters.
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Il. NOTIFICATION LEVELS

When an account is enrolled for PRO-TECH or PRO-TECH CR, one of three levels of notification can be
established for exception alerts. The notification level options, descriptions and samples are provided below.

Notification
Level Description
Transaction Alerts One alert for each transaction.
Account Alerts One alert per account when one or more transactions are received.
Service Alerts One alert per day if an exception exists on one or more accounts.

1. Sample Alerts — Account Level

Via Email:

ALERT

support@achalertinfo
To Liz DelLaere

We have received one or more debit transactions to FFFriends ending in xxxx1111.
Login to PRO-TECH to review.

Sincerely,
DeLaere B&T

Contact Us
Please do not reply to this email If you have questions about your account, please call Customer Service at (800) 555-1234 or email us at support@achalert info

DeLaere B&ET
1 Main St
Ooltewah, TN 37363

Via Text:

Debit transactions received for

xxxx1250. Login to PRO-TECH to
review.

an Alkami Solution Team
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2. Sample Alerts — Transaction Level

Via Email:

Credit ALERT

THANK YOU for DB-791!

We have received a debit transaction to The One and Only ending in xo0m1111 for $100.00 from DDG.

Login to PRO-TECH to review.

Contact Us

Please do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or email us at support@achalert info
DeLaere B&T

1 Main St

Ooltewzh, TN 37363

Via Text:

Credit transaction received
for xxxx7678 for $3,200.00
from Olivia's Omelett. Login to

PRO-TECH CR to review. 9:01 AM

ACH ALENI' Version 1.0.4
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3. Sample Alerts — Service Level

Via Email:

ALERT

support@achalert.info
To Liz Delaere

Transactions for PRO-TECH are available to decision.

Sincerely,
DeLaere B&T

Contact Us
DPlease do not reply to this email. If you have questions about your account, please call Customer Service at (800) 555-1234 or email us at support{@achalert info

DeLaere B&T
1 Main St
Ooltewah, TN 37363

Via Text:

Q Transactions for PRO-TECH are
available to decision.

Transactions for PRO-TECH

CR are available to decision. ., .,

ACH ALENI' Version 1.0.4
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lll. DASHBOARD

A. Using the Dashboard

The Dashboard is the default landing page within the Client portal. If PRO-TECH and/or PRO-TECH CR are
enabled, PRO-TECH/PRO-TECH CR summary box(es) will be displayed. Summary information on current
incoming ACH transactions and status will be displayed for accounts the user has been granted access. The
user must also have the Transaction History user privilege. Active links are embedded within the PRO-TECH
and PRO-TECH CR boxes to permit users to navigate from the dashboard landing page into the PRO-TECH
or PRO-TECH CR service modules or directly to transactions in the status selected. Dashboard totals are
updated in real time as transaction status values are changed by a user.

The content displayed in the PRO-TECH and PRO-TECH CR summary boxes include the following:

PRO-TECH

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Debits $79,281.24 37 ]
Set to Pay $66,877.24 (29 ] Set to Return £12,404.00 (5]
Approved List Exceptions $79,281.24 (37 ] Block List Returns $12,404.00 (3]

PRO-TECH CR

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Credits $71,336.40 [ 35 )
Set to Pay $38,336.40 a Set to Return $33,000.00 (9]
Approved List Exceptions $71,336.40 €  Block List Returns $33,000.00 o
Service Name In the example provided, clicking PRO-TECH or PRO-TECH CR on the left in the title bar

will direct the user to the main menu. The service name may vary by financial institution.

End of Day Cut-Off Time Displayed in the second bar, the day and time transaction decisions will be collected by
the financial institution. Some or possibly all transactions will be ineligible for pay or
return decisions after that time. If a pay or return decision has not been made, the
system pay or system return default will apply.

Total ACH Debits / In the examples above, the total represents the total dollar amount and number of
Total ACH Credits incoming ACH debit transactions (PRO-TECH) or ACH credit transactions (PRO-TECH
CR) received by the financial institution for the accounts the user has access to view.

Approved List Exceptions  This represents the total dollar amount and number of incoming ACH credit or debit

transactions received from companies that are not on the client’s approved list or have
violated an approved list parameter.
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Block List Returns

This represents the total dollar amount and number of incoming ACH credit or debit
transactions received from companies that are on the client’s blocked list and will be
returned.

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Debits $79,281.24 37 ]

Set to Pay $66,877.24 (29 ] Set to Return 512,404.00 (3]
System $66,877.24 (29 ] System 50.00 (0]
User $0.00 (0] User $0.00 [0]
i $0.00 (0] FI $0.00 (0]
Approved List $0.00 (0] Block List $12,404.00 (5]

Approved List Exceptions $79,281.24 €D  Block List Returns $12,404.00 (5]

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Credits $71,336.40 35

Setto Pay $38,336.40 [ 26 ] Set to Return $33,000.00 (9]
System $38,336.40 [ 25 ] System $0.00 (0]
User 0,00 [ 0] User $0.00 (0]
FI $0.00 (0] FI $0.00 (0]
Approved List $0.00 [ 0] Black List $33,000.00 (5]

Approved List Exceptions $71,336.40 €  Block List Returns $33,000.00 (5]

Set to Pay / Set to Return

Transaction History

ACH ALE
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Clicking on the dollar amount hyperlinks on the Set to Pay or Set to Return lines will
expand the view to display a breakdown of the total for each category. System Pay or
Return indicate transactions that will pay or return if no action is taken due to the default
status. User pay or return indicate a Client user decision has occurred. Approved List
indicates the incoming ACH debits (PRO-TECH) or incoming ACH credits (PRO-TECH
CR) that are from companies the client has pre-approved to debit an account or
accounts. The status for these transactions will automatically be set to approved list pay.
Fl pay or return indicate an Fl decision has occurred on behalf of the FI.

The user can click on the dollar amount link for any category to be directed to a filtered
view of the Transaction History. In the examples below, the user has clicked on the dollar
value of debits under Set to Pay — System in PRO-TECH and the dollar value of credits
under Set to Pay — System in PRO-TECH CR, and is directed to a view of exception
transactions that require decision.

Please refer to Section B. PRO-TECH for ACH Debits, Subsection Ill. Transaction
History or Section C. PRO-TECH CR for ACH Credits, Subsection Il. Transaction
History, for more information on this function.

Version 1.0.4
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PRO-TECH:

i . L Date Range
Debit Transaction History i)
EAugust 6, 2020+
Y Filters >
19 transactions totaling $43.590.62
Rows 1-190of 19.
Date Company Account # Amount Current Status Manage
> 08/06/2020 Niveena's Natura XXXXTRT8 $60.00 Pay - System ® Return
¥  08/06/2020 Marshall Modelin XXNXTETE $1,042.00 Pay- System
»  08/06/2020 Leningrad Livery XXXXT678 $86.20  Pay- System
¥ 08/06/2020 Kelsey's Krafts XxXXTETB $768.00  Pay - System
> 08/06/2020 Justice Jeep Sal XXX7678 $500.00  Pay- System
»  08/06/2020 Imojen's Ice Cre XOXT678 $2,800.00 Return - User
» 08/06/2020 Hats on Heart St 7678 $47.00  Pay- System
»  08/06/2020 Garland Guesthou XAXKTET8 $9,000.00 Pay- System
? 08/06/2020 Fine Felines Gro XXXXTBT8 $100.00 Pay- System
: ; 2 Date Range
Credit Transaction History s
=EMNovember 6, 2020~

Y Filters ?

35 transactions totaling $71,336.40

Rows 1 - 25 of 35.
Date Company Account # Amount Current Status Manage
3 11/06/2020 Olivia's Omelatt oo 111 $3,200.00 Pay- System
¥ 11/06/2020 Olivia's Omelett wox1111 $3.200.00  Pay - System ® Reject
> 11/06/2020 Niveena's Natura xox1111 $100.00 Pay- System ® Reject
» 11/06/2020 Niveena's Natura 001111 S100,00  Pay- System
» 11/06/2020 Marshall Modelin woexx1111 $47.00  Pay - System @ Reject
> 11/06/2020 Marshall Modelin w1111 $47.00 Return - User @ Accept
» 11/06/2020 Leningrad Livery o1 111 $2,800.00 Pay- System
$  11/06/2020 Leningrad Livery 1111 $2,800.00 Pay- System @ Reject
ACH ALE S
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1. From the Client Dashboard, a user can also navigate to the PRO-TECH or PRO-TECH CR Modules by
clicking Change Module > PRO-TECH or Change Module > PRO-TECH CR

Dashboard L Manage Users  JliReports = = Transaction View Change Module -

m— PRO-TECH CR

PRO-TECH
End of Day Cut-Off Time: Wednesday 4:00 PM EDT

B. Dashboard and Additional File Loads after EOD

After the end of day cut-off time, all pending ACH transactions are processed and the Dashboard totals will
clear out. If additional ACH transaction files are loaded after the end of day cut-off time but prior to midnight,
they will not be displayed in the Dashboard until midnight, and will be included in the next day’s totals.

C. Create Client Users

NOTE:

> This feature is only available if 1) the Fl is allowing Clients to manage their own
users, and 2) it will only display for Client users who have been designated with
Client Admin status.

A Client User with Admin user privilege can add additional Client users who can then be authorized to use
PRO-TECH or PRO-TECH CR.

1. From Client Dashboard > Click Manage Users.

Transaction View Change Module -

Dashboard j X ‘u1anafe Users o1 Reports -
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2. The Client Users page appears. Click the “Create New User” button.

Create New User R ey

Please select an existing user or create a naw one.
Select User

Search...

2 Doe, jane

2 marks, David

User Type

Normal b

3. The New User page appears. Fill out all fields available, the click “Create User” button.

Cuthbert Allgood

First Name Last Name
Cuthbert Allgood

Email Address Contact Phone Number Cell Phone Number
cuthberta@client&.com {555) 555-5555 [555) 555-5555

4. If the user is configured for standard security login, the New User interface will display these fields.

Cuthbert Allgood

B Active

Username
SYlpgMgkE

First Name Last Name
Cuthbert Allgood

Email Address Contact Phone Number Cell Phone Number
cuthberta@client8.com (555) 555-5555 (555) 555-5555

Version 1.0.4
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5. If the user is configured for single sign-on, the New User interface will display these fields. Please note
that the SSO ID field can have different labels and formats based on the online banking provider being
used. It is important to note that the maximum number of allowable characters in the SSO ID field is

limited to 50.
Judy Dench
Active Admin (Manage other non-admin users)
S50 1D
|Dench
First Name Last Name
Judy Dench
Email Address Contact Phone Number Cell Phone Number
jdench@testbank.com (595) 855-4858 (787) 254-1258

6. The User profile page appears. Scroll down to the “System Roles” section of the page to select what roles
should be enabled for the user. For more information on managing user entitiements, please refer to the
Fraud Prevention HQ Client User Guide, Sections Il and Ill.

System Roles

[all | none]

4 Audit Report Notification Delivery Consolidated
Report Transaction History View

ACH ME Version 1.0.4
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7. Choose from the list of available accounts enrolled in PRO-TECH/PRO-TECH CR the user is entitled to
work with and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

PRO-TECH
Available Accounts Selected Accounts
ks Pﬂa‘ln (:(xx:(1 A 1]
=
WKP Expense (xxx3333) WHKP Secondary (00x2345)

WHKP Payroll (oox2222)

PRO-TECH CR
Available Accounts Selected Accounts
=
WKP Expense (xox3333) WKP Secondary (x0::2345)

E

WP Payroll (oom2222) e

8. For more information regarding Client User Privileges, please refer to Section IV. User Accounts and
Privileges.
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IV. USER ACCOUNTS AND PRIVILEGES

Additional information about creating and editing Client users can be found in the
Fraud Prevention HQ User Guide, Sections Il and Ill.

Defined in this Section are Client user privileges and alerting methods supported for the PRO-TECH
and PRO-TECH CR modules.

E

A. User Privilege Dependencies

Some user privileges are standard, and some are dependent upon features that are enabled by your financial
institution. If you see a privilege below and it does not appear in the Client user interface, the feature has not
been enabled.

Privilege User Feature Dependencies

Act on Approved List Client Transaction History

Act on Blocked List Client Transaction History
Approved List Client
Blocked List Client
Notification Rules Report Client

Change Transaction Status Client Transaction History
Transaction History Client
Notification Rules Client
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B. Client User Privileges

NOTE:

» The Admin user privilege must be enabled.

1. On the Client User page, scroll to PRO-TECH or PRO-TECH CR service section.

2. Choose from the list of available accounts enrolled in PRO-TECH or PRO-TECH CR the user is entitled

to work with and move them to the Selected Accounts box.

> and < move individual accounts between Available and Selected Accounts.
>> and << move all accounts between Available and Selected Accounts.

Available Accounts Selected Accounts
FFF Escrow (xxxx4444) FFFriends (oox1111)
FFF Expense (xxxx3333) FFF Payroll (x0x2222)

==

<<
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3. Selecting PRO-TECH and PRO-TECH CR Client User Privileges. It is important to note that the user
privileges for each of these modules are the same, but must be set up for each module. Screenshots

below will look the same in PRO-TECH or PRO-TECH CR and the instructions can be used to select user
privileges in either module.

a. Selecting all | none

i. By selecting all, the user will be assigned all user privileges.

qferPereges

[all | none]
Act on Approved List Act on Blocked List Approved List
Blocked List Change Transaction Status Notification Rules
Notification Rules Report Transaction History

ii. By selecting none, previously assigned user privileges will be removed.

User Privileges

[all | none]

(] Act on Approved List (] Act on Blocked List [ Approved List
() Blocked List (] Change Transaction Status (] Notification Rules
(J Notification Rules Report [ Transaction History

ACH ME Version 1.0.4
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iii.  Clicking in the box beside each user privilege will add or remove the checkmark from the box.
Adding a checkmark will give the user that privilege, removing the checkmark will remove the
privilege from the user.

Act on Approved List
Blocked List

Notification Rules Report

Act on Approved List User has the privilege to add a company to the
approved list from the Transaction History screen or
Setup > Approved List. When a company is added
to the approved list from Transaction History the
system will only assign the account for the
associated transaction.

Blocked List User has the privilege to manage and view Blocked
List entries.

Notification Rules User has the privilege to view Notification Rules for

Report accounts.

NOTE: This privilege will not appear unless the
Client Manage Notify Rules permission is
enabled in the Admin portal.

Act on Blocked List
Change Transaction Status

B Transaction History

Act on Blocked List User has the privilege to add a company to the
blocked list from the Transaction History screen or
Setup > Block List. When a company is added to the
blocked list from Transaction History the system will
only assign the account for the associated

transaction.
Change Transaction User has the privilege to view transactions and to
Status change the status of transactions. User must also

have the Transaction History User Privilege.

Transaction History User has the privilege to view transactions.

Approved List
Notification Rules

Approved List User has the privilege to manage and view
Approved List entries.

Notification Rules User has the privilege to configure the notification
conditions for accounts.
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1. Select Save User.

a. Success message appears.

User Saved
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V. PREFERENCES

A. Preferences

Preferences allow Client users to bypass the system default landing page and automatically place the user
within the service module and page to perform routine functions. For instance, a user may decide they want
to automatically land in the Transaction History page when entering the system, instead of going to the
Dashboard and clicking on Change Module and then Transaction History.

1. From within the Dashboard or PRO-TECH/PRO-TECH CR Module, click User's Name > Preferences.

PRO-TECH ¥ Setup - diReports ~  ¥E Transaction History Change Module - & Tom Jones -
= Client 3
Wel come —_— [ /& Preferences
O Logout
Please use the above menu to select an action

2. The Preferences page appears.

Preferences
Default Pages

Default Module

- select - v

Default Dashboard Page

- default - v

Default PRO-TECH Page

- default - ¥

Save
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3. Default Module gives the User the ability to choose the default landing page.

Preferences
Default Pages

Default Module

Dashboard e

-select -
PRO-CHEX
Dashboard

PRO-TECH CR

ey D

4. Default PRO-TECH/PRO-TECH CR Page allows the user to select the default landing page within PRO-
TECH or PRO-TECH CR.

Default PRO-TECH Page

| -default- vi

- default -

Reports / Approved List

Reports / Block List

Reports / Notification Rules Report
Setup / Approved List

Setup / Block List
Setup / Notification Rules

Transaction History

5. Once any preferences have been selected, click Save to update the settings.

Preferences

Preferences Saved
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B. PRO-TECH FOR ACH DEBITS

It is important to note that PRO-TECH CR operates as a separate module and the functionality of
that module is explained in Section C., PRO-TECH CR for ACH Credits. PRO-TECH CR will only be
available if enabled by the FI.

>
I. NOTIFICATION RULES

Notification rules establish who should be alerted, how they should be alerted and the conditions that should
prompt an alert. Notification rules can be set on an account by account basis or all accounts can be
configured with the same notification rules. The two notification options are email and SMS text. SMS text
will only be available if the feature has been enabled by the financial institution.

NOTE:

» Client Manage Notify Rules permission must be enabled by the FI.

» By entering a cell phone number for SMS text alerts, you are opting to receive text
messages. Consult your financial institution for associated fees and note that additional
fees from your carrier may apply. To opt out, simply remove the cell phone number from
the user interface and click Save.

A. Setup Notification Method and Condition

1. From the PRO-TECH Module, click Setup > Notification Rules.

PRO-TECH £ Setup ~ diReports ~  i= Transaction History Change Module ~

[ Notification Rules D ]
Approved List
Block List

Please use the above menu to select an action
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2. The Manage Debit Notification Rules page appears. The Selection screen is the first screen of the
Notification Rules page, and will display a list of all accounts that the user has access to.

m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
FFFriends - x0x1111 *
FFF Payroll - xo0x2222 *
FFF Expense - 003333 *
FFF ESCrow - 30004444 *

1

*Accounts with default Notification Rules

-+ Next

NOTE: All accounts with the asterisk (*) symbol have not been configured, and have the default
notification rules, set up with the notification method via email. The email will be delivered to the
default notification contact established by your financial institution, until such time the account is
configured. The default notification condition is to Notify for All ACH Debits.

3. Select the accounts to be configured and move them to the Selected Accounts box.
> and < move individual accounts between Available and Selected Accounts.

>> and << move all accounts between Available and Selected Accounts.

Once all accounts have been selected, click the Next button to proceed.

Sl Contacts  Conditions | Confirm

Account Selection
Select Account(s) Account(s) Selected
FFF Payroll - xo0x2222 * FFFriends - 00001111 * _
FFF Expense - x0xx3333 * =

FFF Escrow - xooxd444 *

*Accounts with default Notification Rules

—p 4+ Mext
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4. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will allow
entry of up to 6 email addresses and up to 6 cell phone numbers if SMS text has been enabled by the
financial institution.

Selection m Conditions = Confirm

Enter the contact information to receive the ALERT

This account is currently set to send all notifications on all ACH debits to Tom Jones (Idelaere@achalert.comy).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 Cell Phone 4

Cell Phone 2 Cell Phone 5

Cell Phone 3 CellPhone &
E-mail

Email 1 Email 4

Email 2 Email 5

Emall 3 Emall 6

5. To add a cell phone number, enter the 10-digit cell number in the Cell Phone 1 field. Repeat this process
to add up to five additional cell phone numbers.

Cell Phone Text

Cell Phone 1 (555) 444-3333 G Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 A Cell Phone 6

6. To add an email address, enter the email address in the Email 1 field. Repeat this process to add up to
five additional email addresses.

E-mail
Email 1 mhart@fffriends.com s mail 4
Email 2 fiones@fffriends.com Email 5
Email 3 | Email 6
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7. Once all cell phone numbers and email addresses have been added, the user can proceed to the next
step by clicking the Next button. Clicking the Next button saves the data and moves to the next step. The
user can click the Back button to go back to the Selection page, but the user will lose all data entered on
this screen.

Selection m Conditions = Confirm

Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH debits to Tom Jones (Idelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 Cell Phone &
E-mail
Email 1 mhart@fffriends.com Email 4
Email 2 fiones@fffriends.com Email 5
Email 3 Email 6
¢ Back  — — -+ Next
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8. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can
define the criteria for when alerts should be sent. It is important to note that the alert criteria controls the
alerting process but does not control the transaction status designated at load time. The transaction
status is controlled by the default setting, approved and block list settings. Only one radio button can be
selected.

Selection Contacts Eeells[[iGI I Confirm

e Notify for all ACH Debits

Select a condition to receive the Alert

Notify only when an ACH Debit is over
Notify only when an ACH Debit meets one or more of the following criteria
The ACH Debit was created from a payment made by check
The ACH Debit was created from a payment over the Internet
The ACH Debit was created from a payment over the phaone
Motify only when an ACH debit is received from a Company not on the Approved List or does not meet the parameters on the Approved List

« Back =+ MNext

Notify for all ACH Debits An alert will be sent for every ACH debit received on the accounts
configured with this notification condition.

Notify only when an ACH Debit is over e Enter the dollar amount.
o Alerts will only be sent when an ACH Debit is received that is greater
than the dollar amount established.
o Alerts will not be sent when an ACH Debit is received that is equal to or
less than the dollar amount established.

Notify only when an ACH Debit meets An alert will be sent for the criteria selected.
one or more of the following criteria
Select one, two or all three criteria:

¢ Payment was made by check and converted into an ACH entry
(includes transactions with an ARC, BOC, POP, or RCK standard entry
class code).

e Payment from a bank account was authorized over the internet or on a
mobile phone (includes transactions with a WEB standard entry class
code).

o Payment from a bank account was authorized over the telephone
(includes transactions a TEL standard entry class code).

Notify only when an ACH Debit is An alert will be sent only when an ACH debit is received on the account
received from a Company that is not on  from a company not set up on the approved list or is set up on the

the Approved List or does not meet the  approved list but violates one of the additional parameters set, such as
parameters on the Approved List maximum amount, frequency, or start or end date.

Alerts will NOT be sent on ACH debit transactions that are received from
companies set up on the approved list and are within approved list
parameters. Those transactions will receive a status of approved list pay.
However, the status can be changed from within Transaction History.

an Alkami Solution Team
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9. Click Next to go to the Confirm page. Review all the information entered, and if correct, click the Save
button. If changes need to be made, click the Back button to navigate back to the appropriate screen.

Selection Contacts Conditions [Kelsllildn

Confirm Motification Rules

Account(s) Selected
001111, 0002222, 0003333, woodd4q

Cell Phone Text

Cell Phone 1: 5554443333 Cell Phone 4:

Cell Phone 2: 8182099402 Cell Phone 5:

Cell Phone 3: Cell Phone 6:
Emails

Address 1: mhart@fffriends.com Address 4

Address 2: fiones@fffriends.com Address 5:

Address 3: Address &:

Notification Condition
Condition: Notify for all ACH Debits
SAVE < —

+ Back e

10. Once Save has been clicked, a success message will appear.

Selection Contacts Conditions Eellalili!

Notification Rules have been configured successfully

11. If the default notification rules have been changed, the account will no longer have an asterisk (*).
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12. If the user would like to restore the default contact and conditions, they may do so by navigating to the
Contacts screen, where there will now be an option to select a checkbox to use default contact and
conditions.

Selection Conditions | Confirm

Enter the contact information to receive the ALERT

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4

Cell Phone 2 (818) 209-9402 Cell Phone 5

Cell Phone 3 Cell Phone 6
E-mail

Email 1 mhart@fffriends.com Email 4

Email 2 flones@fffriends.com Email 5

Emall 3 Email 6

Use Default Contact and Conditions <

+ Back =+ MNext
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Il. TRANSACTION HISTORY

PRO-TECH Transaction History allows authorized users to search and view all ACH debits that have
been received on enrolled accounts, and to make decisions on items. Client users can use
Transaction History to search for ACH transactions for a specific account using one of the many
filtering options available.

A. View Transaction History

NOTE:

» Transactions are available in transaction history for one (1) year.

» The Transaction History user privilege must be enabled to access this screen.

» If the user has been granted the Change Status user privilege and the transaction is available to
decision, the Pay and Return buttons will be available for use.

» Transactions that will be paid will have green shading as a background.

» Transactions that will be returned will have yellow shading as a background.

» Transaction in a return status cannot be changed after the EOD cut-off time.

1. There are two ways to navigate to the Transaction History page. One option is to navigate directly to
PRO-TECH Transaction History from the Dashboard, by clicking on any dollar amount displayed within
the PRO-TECH Dashboard. When using this option, Transaction History will only display transactions
included in the category selected. In the example below, the user would see only transactions with a
System Pay status. To see all transactions, click on Total ACH Debits.

PRO-TECH

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Debits $79,281.24 37 ]

Set to Pay $632,230.24 (27 ] Set to Return $16,051.00 (10 ]
System $560,530.24 e a System $0.00 (0]
User $2,700.00 (1] User $3,647.00 (2]
A $0.00 [ 0] A $0.00 [ 0]
Approved List $0.00 [ 0] Block List $12,404.00 [ 5 ]

Approved List Exceptions $79,281.24 €  Block List Returns $12,404.00 (5]
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Another option is to navigate within the PRO-TECH module, to the View menu and click Transaction

History.
PRO-TECH ¥ setup ~ Jl1 Reports ~ = Transaction HiStory <« Change Module ~
Please use the above menu to select an action

2. The Transaction History page will display all current day transactions for all accounts to which the user
has access.

g . i Date Range
Debit Transaction History i
EEAUQUSL S, 2020«
Y Filters >
19 transactions totaling $43,590.62
Rows 1-19 of 19.
Date Company Account # Amount Current Status Manage
> 08/06/2020 Niveena's Natura XXXXT678 £60.00 Pay - System ® Return
» 08/06/2020 Marshall Modelin XNXATETR $1,042.00 Pay- System
¥ 08/06/2020 Leningrad Livery XXXXTE78 $86.20 Pay- System
¥ 08/06/2020 Kelsey's Krafts XNXXTETS $768.00 Pay- System
> 08/06/2020 Justice Jeep Sal XKXXTETE $500.00 Pay- System
¥ 08/06/2020 Imojen's Ice Cre XXXTE78 $2,800.00 Return - User
» 08/06/2020 Hats on Heart 5t XNXXTETS $47.00 Pay- System
Date Date the ACH debit was presented for payment or loaded to PRO-TECH.
Company Name of the company debiting the account. This information is obtained from the company name

field in the batch header record of the ACH transaction.

Account Number Account number the ACH debit was presented against.

Amount Amount of the ACH debit.
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Current Status

Manage

an Alkami Solution Tea

Status

Pay Pay-System
Pay-User
Approved List-
Pay

Return Return-System

Return-User

Block List-
Return

Description

Transactions that load with this status
indicate the default condition
established by the financial institution
is to pay all transactions on this
account if client users take no action.

Indicates a client user has changed the
status of a transaction from Return to
Pay.

Transactions that load with this status
indicate the company that originated
the transaction was set up on the
approved list for this account prior to
receipt of the transaction and the
transaction amount, frequency and
date are within the allowable
parameters specified in the approved
list entry.

Transactions that load with this status
indicate the default condition
established by the financial institution
is to return all transactions on this
account if client users take no action.

Indicates a client user has changed the
status of a transaction from Pay to
Return.

Transactions that load with this status
indicate the company that originated
the transaction was set up on the
blocked list for this account prior to
receipt of the transaction.

Change Allowed Until

Return deadline, which
varies by financial
institution, account type
and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Up until EOD cut-off time.

Up until EOD cut-off time.

Up until EOD cut-off time.

If the user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision,
(because the return deadline or end of day cut-off time has passed) the button will display as

ineligible.
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a. To filter the date range of items shown, click on the Date Range drop-down.

5 ’ g Date Range
Debit Transaction History <
EEAUQusL 6, 2020~
Y Filters Tomorrow
19 transactions totaling $43.590.62
Rows 1-19 of 19. Yesterday
Date Company Account # Amount Current Status Last 7 Days
> 08/06/2020 Niveena's Natura XXXXT678 $60.00 Pay - System This Month
Last Month
2> 08/06/2020 Marshall Modelin XXHXT 678 $1,042.00 Pay - System
Custom Range
¥  08/06/2020 Leningrad Livery XXXXTE78 $86.20 Pay-System Cancal

b. To narrow the search results, click Filters and a window containing additional search criteria will
appear.

Date Range

DEbIt Transactl(}ﬂ H1St0ry EOctober 1, 2020 - October 31, 2020~

Y Filters v
Min Amount Max Amount Transaction Status
- T | [E—— Pay
Pay - Systemn
Account’ ; Pay - User
P Companies Approved List Pay
- not selectad - il Type a company name or id below Pay - FI
Return
Return - S}-'stem
All companies shown Ketumy= User
Return - FI
Block List Return
he "Ctrl" key to t multiple status types
Apply [“Reset |
Min Amount To search for a transaction by amount within a minimum/maximum range, type the minimum dollar
amount of the transactions into the field.
Max Amount To search for a transaction by amount with a minimum/maximum range, type the maximum dollar
amount of the transactions into the field.
Transaction See #2 in this subsection for definitions of the different transaction statuses.
Status
Account Type an account name or the last 4 digits of the account number into the field to view transactions
for one specific account or select an account from the drop-down menu.
Companies Enter a specific company name.
ACH ALE
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c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items,
the results will be displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.

nsactions totaling $5606,415.33

- 25 of 20,

Rows 1

n : )

e. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The
information shown in this drop-down is an audit history of all the activity that has occurred on the

issue item.

Debit Transaction History

Y Filters

Date Company

v 08/06/2020 Niveena's Natura

Account: Client 8 Main xox7678
Transaction ID: 73179129

Individual Name: Niveena's Naturals

» 08/06/2020 Marshall Modelin

v 08/06/2020 Leningrad Livery

Account: Client 8 Main xox7678
Transaction ID: 73179125

Individual Name: Leningrad Livery

19 transactions totaling $43,590.62

Rows 1-190f19.
Account # Amount
XXXXTE78 $60.00
k ode: PPD
Description: PTTest0815
Trace #: 064208470000438
Company ID: NO0O0OOS8
XXXX7678 $1,042.00
XAXXTETB $86.20

SEC Code: PPD
Description: PTTest0813
Trace #: 064208470000434
Company ID: LO0008

Date Range
EAugust 6, 2020 -

Current Status Manage

Add to Block List

Pay - System

Add to Approved List

Deadline Te Return: 10/03/2020 4:00 PM EDT

Add to Approved List Add to Block List

Deadline Te Pay: Thursday 4:00 PM EDT

>

Account
Transaction ID

Individual Name

ACH ALE

an Alkami Solution Team

Version 1.0.4
Updated 4/15/2021

The account name and last 4 digits of the account number.

Unique ID assigned by the PRO-TECH system when transactions are loaded.

Name of the payee/recipient found in the individual ID field of the incoming ACH
transaction.
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SEC Code Standard entry class code. Reference the NACHA Rule Book for SEC code descriptions.
SEC codes are generally used to classify transactions by the way they were authorized.

Description The description used by the originator of the transaction, as contained in the company
batch header record for the transaction received.

Trace # A unique ID assigned to the transaction by the originator, ACH operator or receiving
depository financial institution.

Company ID A unique identifier for the company that originated the ACH debit. This information is
obtained from the company ID field of the batch header record of the ACH transaction.
This unique identifier is used to match transactions to approved or blocked list entries.

Add to Approved List Will only appear if the user has Act on Approved list user privilege. Please refer to
Subsection lll, Approved List within this Section for more information about this
feature.

Add to Block List Will only appear if the user has Act on Blocked list user privilege. Please refer to
Section 1V, Blocked List within this Section for more information about this
feature.

Download WSUD Option to download a PDF copy of an electronic written statement of unauthorized ACH
Debit signed by the client user when returning an ACH debit that required the dispute
form.

Deadline to Pay/Return Deadline to change the status of any transaction from Pay to Return or from Return to
Pay.

3. A copy of the Transaction History can be downloaded by clicking the Download As CSV button at the
bottom of the Transaction History screen.

1. If the user has been granted the Change Status user privilege and the transaction is eligible for a
decision, a Pay or Return button will appear for use. If the transaction is not eligible for a decision, the
button will display as ineligible.

2. Change Status — Pay

a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay
if the Client determines the debit transaction should be paid.
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b. Click the Pay button under the Manage column.

Date Company Account # Amount Current Status Manage
» 08/06/2020 Niveena's Natura XNHXATE78 $60.00  Pay- System
» 0B/06/2020 Marshall Modelin XXXXTETS $1,042.00 Pay-System
»  08/06/2020 Leningrad Livery XXKXT678 $86.20 Return - User ¢
»  08/06/2020 Kelsey's Krafts XAXXTETS $768.00 Pay - System

c. A success message will appear temporarily in the Manage column, with an option to Add to Approved
List. This link will only appear if the user has the Act on Approved List user privilege. The user can
click the hyperlink embedded in that option to proceed to Add to Approved list. If the user does not
opt to Add to Approved list at this time, the option is still available under the expanded view of this

debit item.
Date Company Account # Amount Current Status Manage
» 08/06/2020 Niveena's Natura 0ONTETS $60.00  Pay - System
» 08/06/2020 Marshall Modelin X0XT678 $1.042.00 Pay-System
> 08/06/2020 Leningrad Livery XXXXT678 $86.20 Pay- User Debit will be paid.
+ Add to Approved List

d. After a few moments, the Change Status button will then change to Return, and the Current Status
column will update to “Pay-User.”

Date Company Account # Amount Current Status Manage

2> 08/06/2020 Niveena's Natura KXNXTE78 $60.00  Pay - System @ Return
2> 08/06/2020 Marshall Modelin XXXXTBT8 $1.042.00 Pay - System @ Return

> 08/06/2020 Leningrad Livery XKXXT678 $86.20 Pay- User ® Return

3. Change Status — Return

a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return
if the Client determines the debit transaction should be returned.
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b. Click the Return button under the Manage column.

Date [ompany Account # Amount Current Status Manage
¥ 08/06/2020 Niveena's Natura XKXKTE7S $60.00 Pay-System ¢
» 08/06/2020 Marshall Modelin XKXKTET $1,042.00 Pay- System
» 08/06/2020 Leningrad Livery XHXXTE78 $86.20 Pay- User
» 08/06/2020 Kelsey's Krafts XKXXTETB $768.00 Pay- System

c. A success message will appear temporarily in the Manage column, with an option to Add to Block
List. This link will only appear if the user has the Act on Block List user privilege. The user can click
the hyperlink embedded in that option to proceed to Add to Block list. If the user does not opt to Add
to Block List at this time, the option is still available under the expanded view of this debit item.

It is important to note that if a Written Statement of Unauthorized Debit is required, the Add to Block
List hyperlink will not appear, as the Written Statement of Unauthorized Debit will pop-up instead. In
this case, the user must expand the view of the debit item to Add to the Block List.

Date Company Account # Amount Current Status Manage

? 08/06/2020 Niveena's Natura XNHXT678 £60.00  Return - User Debit will be returned
4+ Add to Block List

» 08/06/2020 Marshall Modelin XXHNTBT8 $1,042.00 Pay - System

® Return

d. About Written Statements of Unauthorized Debits: If the financial institution has enabled the Written
Statement of Unauthorized Debit feature, the Fl has the option to waive WSUD for corporate account
same-day returns. If the waive WSUD configuration is on, all returns will be given an R29 return
reason code regardless of the SEC code of the transaction. This behavior is consistent with how ACH
debit blocksf/filters work today.
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e. If the financial institution has enabled and required a Written Statement of Unauthorized Debit to be
completed to return a transaction, a Written Statement of Unauthorized Debit pop-up screen will
appear. The user will be prompted to select a reason for the return of the transaction by clicking in
one of the radio buttons by the appropriate return reason. Once the reason has been selected, click
Next to continue. Clicking Cancel will cancel the process and the user will be returned to the
Transaction History screen.

Written Statement of Unauthorized Dehit

To return this transaction you are required to complete a Written Statement of Unauthorized Debit.
This transaction is a PPD ACH debit for $800.50 to Client 3 from your account xxxx1111
A PPD (Prearranged Payment and Deposit Entry) is a one-time or recurring debit used to transfer funds from a consumer account.
Please select the reason you are returning this transaction:
O Never Authorized to Debit Account
 Authorized ACH Debit Amount Incorrect
) Debited Before Date Authorized
O Debit Authorization was Revoked
 3rd Party Did Not Send Funds to Payee
O Improperly reinitiated l
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f. Depending on the return reason selected, the user may have an additional screen to provide more
information about the return reason, such as correcting the ACH Amount (example shown below), or
selecting the date the debit was authorized, etc. Once this screen has been completed, click Next to
continue. Clicking Cancel will cancel the process and the user will be returned to the Transaction
History screen.

Written Statement of Unauthorized Debit

< Change Reason
Return Reason: Authorized ACH Debit Amount Incorrect

Please enter the amount you authorized:

b ]

g. The final screen within the pop-up window is the Written Statement. The content of the Written
Statement will display based on the return options valid for the transaction being disputed. The
Written Statement must be completed for the transaction to be returned. If the Written Statement is
abandoned, the transaction status will remain unchanged.

Written Statement of Unauthorized Debit

« Change Reason
Return Reason: Authorized ACH Debit Amount Incorrect

I, Tom Jones, state that I am an authorized signer or have corporate authority to act on the account "FFFriends” ending 1n sxxx1111. 1
am returning this transaction because:

I authorized Client 3 to originate one or more ACH entries to debit funds from an account at DeLaere B&T, but the amount debited 13
different than the amount I authorized to be debited. The amount I authorized is S800.00.

I certify that the foregoing is true and correct.

1 consent to electronically signing this form [[|

Electronic Signature

Tom Jones

Download PDF Copy

ACH ALE Updtod 4/15/2021
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h. The client user must consent the Written Statement of Unauthorized Debit by electronically signing
the form. The user must click the checkbox next to the statement “| consent to electronically signing
this form.” Once the user has done so, the “e-signature needed” button will change to a Sign button.
In addition, a PDF copy of the Written Statement will download by default. The user can opt not
to download by unchecking the Download PDF Copy option. Once the screen is correct, click Sign to
proceed with the return process.

Written Statement of Unauthorized Debit

« Change Reason
Return Reason: Authorized ACH Debit Amount Incorrect

I. Tom Jones, state that I am an authorized signer or have corporate authority to act on the account "FFFriends” ending in xxxx1111. 1
am returning this transaction because:

I authorized Client 3 to originate one or more ACH entries to debit funds from an account at DelLaere B&T, but the amount debited is
different than the amount I authorized to be debited. The amount I authorized 1s $800.00.

I certify that the foregoing 1s true and correct.

I consent to electronically signing this form

Electronic Signature

Tom Jones

Download PDF COpY G 1

i. A success message will appear, and a copy of the Written Statement will download to the user’s PC,
unless the user opted out.

et
Debit will be returned

s

l\__ ) WrittenStatement_....pdf

j-  The Change Status button will then change to Pay, and the Current Status column will update to
“Return-User.”
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lll. APPROVED LIST

The Approved List allows Clients to identify companies that are allowed to debit an account or accounts and
set parameters to control the debit activity. There are multiple ways to populate the approved list. It can be
done through the Setup > Approved List menu option, or users can add companies to the approved list from
Transaction History. It is important to note that companies added from Transaction History will only be added
to the account associated with the transaction it was added on. To allow the company to debit other
accounts, the user must edit the approved list.

Users can edit and delete companies from their approved list.

The way PRO-TECH identifies approved companies is by verifying the company ID ONLY in the batch
header record of the incoming ACH transaction is an exact match. If an exact match is found, if
additional parameters have been established such as maximum amount, frequency, start/end date, the
values found in the ACH batch/transaction are compared to the list to determine if an alert is required and the
transaction status that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the approved list
is shown below.

Verifies Company ID

101 026013262 06420851820080605508094101DeLacre Bank & Trust  FRB Atlanta
52002shland Armament PEDETT=st0820 200806 1064208470000031
6220260132627677677678 0000150000200008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
820000000200052026520000000300000000001 0008 064208470000031
5200Biclab Birmingha I B00008]  PPDPTTEest0805 200806 1064208470000032
6220260132627677677678 0000130000B0000E Biolab Birmingham 0064208470000355
6270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
820000000200052026520000002500000000001 0008 064208470000032
5200Cartwright Car S C00008 PPDPTTest0806 200806 1064208470000033
6220260132627677677678 0000800000C00008 Cartwright Car Sales 0064208470000397
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop D0000B PPDPTTest0804 200806 1064208470000034
6220260132627677677678 0000170000D00008 Del Aire Developers 0064208470000398
6270260132627677677678 0000270000D00008 Del Aire Developers 0064208470000359
82000000020005202652000000270000000000170000D00008 064208470000034

Compares against Maximum Amount Parameter

101 026013262 06420851820080605502094101Delacre Bank & Trust FRE ZAtlanta

5200ashland Armament 200008 PPDPTTest0820 200806 1064208470000031
6220260132627677677678 0000150000400008 Zshland Armamsnt 0064208470000353
6270260132627677677678 00000300004200008 Zshland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000A00008 064208470000031
5200Biolab Birmingha BOOOOS PPDPTTest08B05 200806 1064208470000032
6220260132627677677678 C000130000p00008 Biolabk Birmingham 0064208470000355
6270260132627677677678 00o0250000p00008 Biolak Birmingham 006420847000035%6
82000000020005202652000000250000000000130000B00008 064208470000032
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Compares aqgainst Frequency and Start/End Date Parameters

101 026013262 064208518200806095000594101Deliacre Bank & Trust FEB Atlanta

52004a=shland Armament 00008 PPDPTT=st0820 200806 1064208470000031
6220260132627677677678 0000150000200008 Ashland Armamel 0064208470000353
6270260132627677677678 0000030000200008 Ashland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000200008 0€4208470000031
5200Biolab Birmingha BQOOODS8 PPDPTTest0802 1064208470000032
6220260132627677677678 0000130000B00008 Biolak Birmingham 0064208470000355
6270260132627677677678 0000250000B000D0B Biolab Birmingham 0064208470000356
820000000200052026520000002500000000001320000B00008 064208470000032

If the notification criteria is set to Notify when a debit comes in from a company not on the approved list or
violates approved list parameters, PRO-TECH will alert designated contacts when a debit is received from an
unknown company or from a company that is set up, but violated the parameters. If notification criteria are set
to all debits, debits over a certain amount or certain types of debits, the system will NOT alert for approved
list violations. If the transaction meets approved list criteria, it will receive a status of Approved List-Pay. If it
does not, it will receive the system default status.

A. Add to Approved List From Setup Menu

NOTE:

» Approved List user privilege required.

1. Within the PRO-TECH module, click Setup > Approved List.

PRO-TECH £ Setup ~ i Reports - i= Transaction History Change Module =

Notification Rules
[ Approved List D ]
Block List

Please use the above menu to select an action
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2. The Debit Approved List will display. Click the Create button to add an entry to the Approved List.

@ Delete Selected

+ (regte <G
Company ID ¢

Delete

O ACME

Acme Widget

Company Name &
Maximum Amount

$20,000.00

Approved List

Frequency

Start Date

06/18/2020

End Date Edit

Edit

@ Cancel

3. The Add Company page will display. Complete all applicable fields in the top section of the screen.

Approved Company

Company Detail

Company ID Company Name
Max Amount Frequency No Frequency -
Start Date 06/18/2020 End Date
Add Accounts to Approved List
FFF Escrow - xxxx4444
FFF Expense - x¢xx3333
FFF Payroll - xxxx2222
FFFriends - xxxx1111 >
~ Save @ Cancel
Field Name Optional or Field Validated Field Content Notes
Required
Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
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the parameters when
the date is equal to or
after the Start Date.

e The transaction does
not meet the
parameters when the

based on the
settlement date.

Field Name Optional or | Field Validated Field Content Notes
Required
Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
Max Amount Optional e The transaction meets e Blank: Any amount | Valid Characters:
the parameters when is accepted and will = 0-9
the amount the amount not trigger an alert.
is less than or equal to o Zero: Will not be
the Max Amount accepted and entry
e The transaction does will not save to
not meet the Approved List.
parameters when the e Highest amount:
amount is greater than $99,999,999.99
the Max Amount.
Frequency Optional e [If multiple transactions | ¢ Daily: 1 business Counter:
are on a file, the sort day
order is highest to e Weekly: 7 calendar | The counter begins with
lowest dollar value. days the first transaction
e Ifthe transaction with | e Bi-Weekly: 14 received after the
the highest dollar value calendar days Company and Account is
exceeds the Maximum |« Monthly: Monthly added to the Approved
Amount, all transactions date-to-date List regardless if the
on the file are not e Quarterly: Quarterly transaction meets or does
approved. date-to-date not meet the parameters
¢ [f the transaction with ° Year|y: Year|y date- of the Approved List.
the highest dollar value to-date
is equal to or less than
the Maximum Amount, | Date-to-Date
that transaction is Exceptions:
approved and all other | ¢ Non-Leap Year
transactions on the file January 29, 30, 31:
are not approved. February 28
o Leap Year January
30, 31, February 29
e March 31: April 30
e May 31: June 30
e August 31:
September 30
e October 31:
November 30
Start Date Required e The transaction meets The Start Date is Valid Characters:

0-9
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Field Name Optional or | Field Validated Field Content Notes

Required
date is before the Start
Date.
End Date Optional e The transaction meets The End Date is Valid Characters:
the parameters when based on the 0-9

the date is equal to or settlement date.
before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

4. Choose from the list of available accounts to add to the Approved List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Approved List

FFF Expense - 03333 FFF Escrow - xxxx4444

FFF Payroll - xo0x2222
FFFriends - xxxx1111

=+

~ Save @ Cancel

5. Once the entry is completed, click Save to save it to the Approved List. A success message will appear.

Approved Company Saved Successfully
+ Create
Approved List
CompanyID ¢ Company Name <
Delete Maximum Amount Frequency Start Date End Date Edit
|| ACME Acme Widget $20,000.00 06/18/2020 Edit
O TJONEST Tom Jones $50,000.00 MONTHLY 06/18/2020 Edit
@ Delete Selected @ Cancel

an Alkami Solution Team
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6. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be
taken to the Company’s screen.

7. To delete any entity on the Approved list, click the checkbox next to the appropriate row, and click the
Delete Selected button.

B. Add to Approved List from Transaction History

NOTE:

» Transaction History user privilege required.
» Acton Approved List user privilege required.

1. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Account # Amount

XXXX7678 $60.00  Return - User

$1,042.00 Pay - System

Date Company Current Status Manage

? 08/06/2020 Niveena's Natura

v 08/06/2020 Marshall Modelin XXHXT678

® Return

Account: Client 8 Main xxx7678
Transaction ID: 73179127

Individual Name: Marshall Modeling

SEC Code: PPD
Description: PTTest0814
Trace #: 064208470000436

Company ID: MO0008

Add to Approved List Add to Block List

Deadline To Return: 10/03/2020 4:00 PM EDT

Version 1.0.4
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2. Click the Add to Approved List button to add a company. The Add Company pop-up window will appear.

Add Company to Approved List

Company Id Company Name Start Date End Date
MO0008 Marshall Modelin E 08/06/2020 =

Max Amount Frequency
1042 - none - g

Save Cancel

Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header
record of the transaction received.
Company Name Populated with the company name data from the batch header v
record of the transaction received.
Max Amount Populated with amount of transaction received. v
Frequency Left blank. v
Start Date Populated with the date of transaction received. v
End Date Left blank v

3. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History without
adding to the Approved List.

4. The user will be directed to the Transaction History page once the company has been added to the
Approved List.
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C. Approved List Failure Reasons

When a transaction exception is triggered because of Approved List parameters, the system default status
will apply. Examples of types of failure reasons are listed below.

Reason Description Sample
Transaction Dollar amount of transaction is

. . . Current Status Manage
Amount is greater than the maximum amount in
Greater than the Approved List entry. Pay - System
Approved List
Amount Add to Approved List Add 1o Block List

Deadline To Return: 08/16/2020 5:00 PM EDT

Approved List Violation: Transaction Amount: 1500 is greater than Approved
List amount: 1000

Frequency Transaction violates the frequency set
Failure in the Approved List entry.
Add to Approved List Add to Block List
Deadline To Return: 10/03/2020 4:00 PM EDT
Approved List Violation: Frequency: YEARLY Last Transaction Date:
06-AUG-20
Out of Date Transaction was presented prior to
Range the Start Date or after the Ending Pay - System

Date of the Approved List entry.

Add to Approved List Add to Block List

Deadline To Return: 08/13/2020 5:00 PM EDT
Approved List Violation: Out of Date range - Start Date: 18-JUN-20 End Date:

ACH ME Upc\lgil;gséozllq/ ;.5(}.;021 Page 49 of 97

an Alkami Solution Team



IV. BLOCKED LIST

The Blocked List is an optional feature which, if enabled by the Fl, allows Clients to identify companies that
are NOT allowed to debit an account or accounts. There are multiple ways to populate the blocked list. It can
be done through the Setup > Approved List menu option, or users can add companies to the blocked list from
Transaction History. It is important to note that companies added from Transaction History will only be added
to the account associated with the transaction it was added on. To prevent the company from debiting other
accounts, the user must edit the blocked list.

Users can edit and delete companies from their blocked list.

If an exact match is found, if additional parameters have been established such as frequency, start/end date,
the values found in the ACH batch/transaction are compared to the list to determine if an alert is required and
the transaction status that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the blocked list is
shown below.

Verifies Company ID

101 026013262 06420851820080605302094101Delae Bank & Trust FEE Atlanta

3200&shland Armament PPDPTTest0820 200808 1064208470000031
6220260132627677677678 00001530000200008 Ashland Armament 0064208470000353
6270260132627677677678 0000030000200008 Ashland Armaments 0064208470000354
82000000020005202652000000030000000000 0008 0€4208470000031
5200Biclab Birmingha BOOOODS8 PPDPTTest0803 200806 1064208470000032
6220260132627677677678 0000130000B00008 Biolab Birmingham 0064208470000355
6270260132627677677678 0000250000B0000B Biolab Birmingham 0064208470000356
82000000020005202652000000250000000000120000800008 0€420B8470000032
5200Cartwright Car 3 c00008 PPDPTT=st0806 200806 1064208470000033
62202601326276776776738 0000B00000C0D008 Cartwright Car Sales 0064208470000357
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop Dooo0s PPDPTTe=st0804 200806 1064208470000034
6220260132627677677678 0000170000D0O000B Del Rire Developesrs 00&4208470000358
62702601326276776776738 0Q00270000D0000B Del Aire Developers 0064208470000355
82000000020005202652000000270000000000170000D00008 064208470000034

Compares against Frequency and Start/End Date Parameters

101 026013262 064208518200806095000594101Deliacre Bank & Trust FRE Atlanta

S5200ashland Armamsnt n00008 PPDPTT=st0820 200806 1064208470000031
62202601326276776776738 0000150000200008 Ashland Armamefl 0064208470000353
6270260132627677677678 0000030000200008 ZAshland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000200008 0€4208470000031
5200Biclab Birmingha BOOOOS PPDPTT=st0805 1064208470000032
6220260132627677677678 0Q000130000B00008 Biclab Birmingham 0064208470000355
6270260132627677677678 0000250000B00008 Eiolak Birmingham 00&4208470000356
82000000020005202652000000250000000000130000E00008 0€4208470000032
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Blocks are intended to automatically return items and alerts are not sent out. However, Clients can see those
items in transaction history and have the option to pay them before EOD cut-off time. The dashboard will be
updated in the next release to display blocked item summary information.

A. Add to Blocked List From Setup Menu

NOTE:

> Act on Blocked List user privilege required.

1. Within the PRO-TECH module, click Setup > Blocked List.

PRO-TECH £ setup - i Reports - & Transaction History Change Module -

Notification Rules
Approved List
\[ Block List D ]

Please use the above menu to select an action

2. The Debit Block List will display. Click the Create button to add an entry to the Block List.

+ Create @
Block List
Company ID % Company Name %
Delete Start Date End Date Edit
O SKETCH Sketchy Corp 06/19/2020 Edit
@ Delete Selected @ Cancel
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3. The Add Company to Debit Block List page will display. Complete all applicable fields in the top
section of the screen.

Blocked Company

Company Detail

Company ID Company Name

Start Date 06/19/2020 End Date

Add Accounts to Block List

FFF Escrow - xoxood444
FFF Expense - xxxx3333
FFF Payroll - xxxx2222
FFFriends -x000(1111

1

~ Save @ Cancel

Field Name Optional or Field Validated Field Content Notes
Required

Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

an Alkami Solution Team
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Field Name Optional or | Field Validated Field Content Notes

Required
Start Date Required e The transaction meets The Start Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.
after the Start Date.
e The transaction does
not meet the
parameters when the
date is before the Start
Date.
End Date Optional e The transaction meets The End Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.

before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

5. Choose from the list of available accounts to add to the Approved List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Block List

FFF Expense - 00003333 ] FFF Escrow - xxd444

FFF Payroll - xxxx2222
FrFriends - xox1111

=1

~ Save @ Cancel
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6. Once the entry is completed, click Save to save it to the Blocked List. A success message will appear.

Blocked Company Saved Successfully
+ Create
Block List
Company ID ¢ Company Name $
Delete Start Date End Date Edit
|| MAX Maximum Focus 06/19/2020 Edit
O SKETCH Sketchy Corp 06/19/2020 Edit
@ Delete Selected @ Cancel

7. To edit any entity on the Blocked List, click the Edit hyperlink at the end of the appropriate row to be
taken to the Company’s screen.

8. To delete any entity on the Blocked list, click the checkbox next to the appropriate row, and click the
Delete Selected button.

B. Add to Blocked List from Transaction History

NOTE:

» Transaction History user privilege required.
> Act on Blocked List user privilege required.

1. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Date Company Account # Amount Current Status Manage

» 08/06/2020 Olivia's Omelett HIOHATETS $800.00  Pay - System
¥ 08/06/2020 Marshall Modelin XHXXTETE $1,042.00 Pay- System

Account: Client 8 Main xoxx7678 SEC Code: PPD Add to Approved List || Add to Block List
Transaction ID: 73179127 Description: PTTest0814 7

Deadline To Return: 10/03/2020 4:00 PM EDT
Individual Name: Marshall Modeling Trace #: 064208470000436

Company ID: MOD0O0D8
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2. Click the Add to Blocked List to add a company. The Add Company pop-up window will appear.

Add Company to Block List
Company Id Company Name Start Date End Date
M00008 Marshall Modelin & 08/07/2020 =
Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header

record of the transaction received.

Company Name

Start Date

Populated with the company name data from the batch header v
record of the transaction received.
Populated with the date the transaction was received.

<

End Date

Left blank

3. Click the Save button to add to Block List. Click Cancel to return to the Transaction History without adding
to the Block List.

4. The user will be directed to the Transaction History page once the company has been added to the Block

List.

C. Block List Failure Reasons

When a transaction exception is triggered because of Block List parameters, the system default status will
apply. Examples of types of failure reasons are listed below.

Reason Description Sample

Out of Date Transaction was presented prior to the

Range Start Date or after the Ending Date of Block List Return e
@ Ineligible

the Approved List entry.

Add to Approved List Add to Block List

Blocked List Violation: Account on Blocked List
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V. REPORTS

NOTE:
> Reports are available for one (1) year.

A. Notification Rules Report

The Notification Rules report provides authorized Client users a method to view the notification conditions set
for each account enrolled for the service. The report allows users to see the default account setting
established by the financial institution, as well as the notification condition and contact information
established by the Client.

1. Within the PRO-TECH Module, click Reports > Notification Rules Report.

PRO-TECH ¥ Setup ~ o1 Reports ~ iE Transaction History Change Module ~

Approved List
Block List

WE| CO ][ Notification Rules Report ]4—

Please use the above menu to select an action

Updated 4/15/2021 Page 56 of 97
an Alkami Solution Team

ACH ALENI' Version 1.0.4



2. The Notification Rules Report page appears.

Notification Conditions for Client 3
Account Number Accoru mt Not\ﬂ;a(ion Amount Check Internet Phone Email Cellphone
Setting Condition
1. mhart@fffriends.com 1. 5554443333
2. fjones@fffriends.com 2. 8182099402
: f 3. 3
oxx1111 Pay All All Debits i 5
5. 5
6. 6.
1. mhart@fffriends.com 1.5554443333
2. fijones@fffriends.com 2.8182099402
KXXX2222 Pay All All Debits i _31
50 5.
6. 6.
1. mhart@fffriends.com 1. 5554443333
2. fiones@fffriends.com 2.8182099402
Xxx3333 Pay All All Debits j i
5. 5
6. 6
1. mhart@fffriends.com 1.5554443333
2. fjones@fffriends.com 2. 8182099402
w44 Pay All All Debits i _31
50 5
6. 6
Total count: 4
Account Number The last 4 digits of each account number enrolled.
Account Setting The default pay or return setting established by the financial institution when the account
was enrolled for the service.
e Pay All
e Return All
Notification Condition See Notification Rules section for detailed descriptions:
¢ All Debits

e Debit Over the Debit Amount
e Company Not in Approved List

Debit Amount If Notification Condition is Debit Over the Debit Amount, the amount entered will be
displayed.
Check ¢ If Notification Condition is ACH Debits with Check/Internet/Phone is selected

If Check is selected, Y will be displayed.

Internet o If Notification Condition is ACH Debits with Check/Internet/Phone is selected
e If Internet is selected, Y will be displayed.
Phone o If Notification Condition is ACH Debits with Check/Internet/Phone is selected
e If Phone is selected, Y will be displayed.
Email Email address(es) that will receive email alerts.
Cell Phone Cell phone number(s) that will receive email alerts; this section will display only if the

financial institution is configured to allow SMS Text alerts.
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B. Approved List Report

NOTE:

» Approved List Report user privilege required.

The Approved List report makes it easy for Client users to identify all the companies set up on the approved
list for a specific account.

1. Within the PRO-TECH Module, click Reports > Approved List.

PRO-TECH ¥ Setup ~ i Reports ~ iE Transaction History Change Module =
[ Approved List G
Block List

We | COl (otification Rules Report

Please use the above menu to select an action

2. The Approved List Report page appears.

Approved List
Account: - All - -
Search Cancel
Approved List
Company ID & Company Name & Maximum Amount & Frequency < Start Date ¢ End Date & Action
ACME Acme Widget $20,000.00 = YEARLY 06/18/2020 View

3. The Account drop-down menu will allow the user to search approved list entries by account number.
Select the account number from the drop-down menu. Click the Search button to proceed.

Approved List

Account: [_ Al - I vl

- All-
FFFriends - xoox1111
FFF Payroll - xxxx2222
FFF Expense - Xxxx3333
FFF Escrow - 004444 Approved List
Company ID ¢ Company Name & Maximum Amount < Frequency ¢ Start Date & End Date & Action

wearch Cancel
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4. All Approved List entries for that account number will be displayed.

Approved List

Account:

Company ID &
ACME
CANOVA
CLEARY
RICHARDS
TJONES1

Company Name Maximum Amount Frequency < Start Date & End Date & Action

. Acme Widget . $20,000.00 = YEARLY . 06/18/2020 View
Richard Canova $10,000.00 DAILY 06/19/2020 View
Frank Cleary $1,000.00 WEEKLY 06/19/2020 View
Richards & Assoc $10,000.00 MONTHLY 06/19/2020 07/19/2020 View
Tom Jones $50,000.00  MONTHLY 06/18/2020 View

FFFriends - 20001111 =

Search Cancel

Approved List

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH
welcome screen.

6. The user
column.

may view Approved List details for any company by clicking the View hyperlink in the Action

Approved List

Account:

CompanyID ¢
ACME
CANOVA

Company Name % Maximum Amount & Frequency % Start Date ¢ End Date ¢ Action
Acme Widget $20,000.00 = YEARLY 06/18/2020 View < m—
Richard Canova $10.000.00 = DAILY 06/19/2020 View

FFFriends - 21111 b

Search Cancel

Approved List

7. The Approved List Details screen will display company detail, including all accounts included on the
Approved List. Click the Back button to return to the Approved List Report screen

Company Detail

Company ID
Max Amount
Start Date

Accounts

ACME Company Name Acme Widget
$20,000.00 Frequency YEARLY
06/18/2020 End Date

FFFriends - xxxx1111
FFF Payroll - xo0x2222
FFF Expense - xxxx3333
FFF Escrow - xooud444

Back

Version 1.0.4
Updated 4/15/2021

ACH AI.EI‘I'

an Alkami Solution Team

Page 59 of 97



C. Block List Report

NOTE:

» Block List Report user privilege required.

The Block List report makes it easy for Client users to identify all the companies set up on the block list for a
specific account.

1. Within the PRO-TECH Module, click Reports > Block List.

PRO-TECH £F setup ~ il Reports iE Transaction History Change Module ~

Approved List
[ Block List ] G

We | COl notification Rules Report

Please use the above menu to select an action

2. The Block List Report page appears.

Block List
Account: - All - -
Search Cancel
Block List
Company ID & Company Name & Start Date & End Date & Action
MAX Maximum Focus 06/20/2020 View

3. The Account drop-down menu will allow the user to search approved list entries by account number.
Select the account number from the drop-down menu. Click the Search button to proceed.

Block List

Account: [-AII . [ -]
- All-
FFFriends - xoocx1111 g2sh gaoed
FFF Payroll - xo0m2222
FFF Expense - xxxx3333
FFF Escrow - xxxx4444 Block List

Company ID & Company Name & Start Date & End Date ¢ Action
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4. All Block List entries for that account number will be displayed.

Block List
Account: FFFriends - xoooc1111 =
Search Cancel
Block List
Company ID ¢ Company Name 2 Start Date ¢ End Date ¢ Action
AD3 Armada Resources 06/19/2020 View
DD1 Dogwood Designs 06/19/2020 View
MAX Maximum Focus 06/20/2020 View
SKETCH Sketchy Corp 06/19/2020 View

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH
welcome screen.

6. The user may view Block List details for any company by clicking the View hyperlink in the Action column.

Block List
Account: FFFriends - 30001111 -
Search Cancel
Block List
CompanyID < Company Name & Start Date < End Date & Action
A03 Armada Resources 06/19/2020 View - u—
DD1 Dogwood Designs 06/19/2020 View

7. The Block List Details screen will display company detail, including all accounts included on the Block
List. Click the Back button to return to the Block List Report screen.

Company Detail

Company ID AD3 Company Name Armada Resources
Start Date 06/19/2020 End Date
Accounts

* FFFriends - 01111
* FFF Payroll - xoox2222
* FFF Expense - xxxx3333
* FFF Escrow - xxxx4444

Back < m—
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C. PRO-TECH CR FOR ACH CREDITS

It is important to note that PRO-TECH CR operates as a separate module and the functionality of
that module is explained in Section C., PRO-TECH CR for ACH Credits. PRO-TECH CR will only be
available if enabled by the FI.

E

I. NOTIFICATION RULES

Notification rules establish who should be alerted, how they should be alerted and the conditions that should
prompt an alert. Notification rules can be set on an account by account basis or all accounts can be
configured with the same notification rules. The two notification options are email and SMS text. SMS text
will only be available if the feature has been enabled by the financial institution.

NOTE:

» Client Manage Notify Rules permission must be enabled by the FI.

» By entering a cell phone number for SMS text alerts, you are opting to receive text
messages. Consult your financial institution for associated fees and note that additional
fees from your carrier may apply. To opt out, simply remove the cell phone number from
the user interface and click Save.

A. Setup Notification Method and Condition

1. From the PRO-TECH CR Module, click Setup > Notification Rules.

PRO-TECHCR  %ksSetup~  JiReports ~  i= Transaction History Change Module ~

Notification Rules | <G

Approved List
We I ( Block List

Please use the above menu to select an action
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2. The Manage Credit Notification Rules page appears. The Selection screen is the first screen of the
Notification Rules page, and will display a list of all accounts that the user has access to.

m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected

CPP767Testl - 07677 *
Client & Main - xxxx7678 *

Client 8 Expense - xxxx7673 * i

*Accounts with default Notification Rules

+ Next

NOTE: All accounts with the asterisk (*) symbol have not been configured, and have the default
notification rules, set up with the notification method via email. The email will be delivered to the
default notification contact established by your financial institution, until such time the account is
configured. The default notification condition is to Notify for All ACH Credits.

3. Select the accounts to be configured and move them to the Selected Accounts box.
> and < move individual accounts between Available and Selected Accounts.

>> and << move all accounts between Available and Selected Accounts.

Once all accounts have been selected, click the Next button to proceed.

m Contacts Conditions Confirm

Account Selection

Select Account(s) Account(s) Selected
CPP767Test1 - 007677 * ] Client 8 Main - xxxx7678 *

15

Client 8 Expense - 07679 *

-+

*Accounts with default Notification Rules

— ., Next

an Alkami Solution Team
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4. The Contacts screen is the second screen of the Notification Rules page. The Contact screen will allow
entry of up to 6 email addresses and up to 6 cell phone numbers if SMS text has been enabled by the

financial institution.

Selection Conditions Confirm

Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH credits to Lera Lynn (Idelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 Cell Phone 4
Cell Phone 2 Cell Phone 5
Cell Phone 3 Cell Phone 6
E-mail
Email 1 Email 4
Email 2 Email 5
Email 3 Email 6
+ Back

5. To add a cell phone number, enter the 10-digit cell number in the Cell Phone 1 field
to add up to five additional cell phone numbers.

. Repeat this process

Cell Phone Text

Cell Phone 1 (555) 444-3333 G Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 A Cell Phone 6

6. To add an email address, enter the email address in the Email 1 field. Repeat this process to add up to

five additional email addresses.

E-mail
Email 1 leralynn@client8.com ——Em3ail 4
Email 2 miked@client&.com Email 5
Email 3 Email 6

ACH ALE Updtod 4/15/2021
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7. Once all cell phone numbers and email addresses have been added, the user can proceed to the next
step by clicking the Next button. Clicking the Next button saves the data and moves to the next step. The
user can click the Back button to go back to the Selection page, but the user will lose all data entered on
this screen.

Selection Conditions = Confirm

Enter the contact information to receive the ALERT
This account is currently set to send all notifications on all ACH credits to Lera Lynn (Idelaere@achalert.com).

To change this enter contact information below.

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4
Cell Phone 2 (818) 209-9402 Cell Phone 5
Cell Phone 3 Cell Phone 6
E-mail
Email 1 leralynn@client8.com Email 4
Email 2 miked@client8.com Email 5
Email 3 Email 6
« Back < — —p o+ Next

8. The Conditions screen is the third screen of the Notification Rules page. On this page, the user can
define the criteria for when alerts should be sent. It is important to note that the alert criteria controls the
alerting process but does not control the transaction status designated at load time. The transaction
status is controlled by the default setting, approved and block list settings. Only one radio button can be
selected.

Selection Contacts EeG[{EM Confirm

e  Notify for all ACH Credits

Select a condition to receive the Alert

Notify only when an ACH Credit is over

Natify only when an ACH credit is received from a Company not on the Approved List or does not meet the parameters on the Approved List

Notify for all ACH Credits An alert will be sent for every ACH credit received on the accounts

configured with this notification condition.

an Alkami Solution Team
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Notify only when an ACH Credit is over

Notify only when an ACH Credit is
received from a Company that is not on
the Approved List or does not meet the
parameters on the Approved List

o Enter the dollar amount.
o Alerts will only be sent when an ACH Credit is received that is greater

than the dollar amount established.

o Alerts will not be sent when an ACH Credit is received that is equal to

or less than the dollar amount established.

An alert will be sent only when an ACH credit is received on the account
from a company not set up on the approved list or is set up on the
approved list but violates one of the additional parameters set, such as
maximum amount, frequency, or start or end date.

Alerts will NOT be sent on ACH credit transactions that are received from
companies set up on the approved list and are within approved list
parameters. Those transactions will receive a status of approved list pay.
However, the status can be changed from within Transaction History.

9. Click Next to go to the Confirm page. Review all the information entered, and if correct, click the Save
button. If changes need to be made, click the Back button to navigate back to the appropriate screen.

Selection Contacts Conditions Kelalilg]

Confirm Motification Rules

XXXX7678

Cell Phone 1: 5554443333
Cell Phone 2: 8182099402

Cell Phone 3:
Address 1: leralynn@client8.com
Address 2: miked@client8.com

Address 3

Condition: Notify for all ACH Credits

+ Batk = —

Account(s) Selected

Cell Phone Text
Cell Phone 4:
Cell Phone 5:
Cell Phone &:
Emails
Address 4:
Address 5:
Address &

Notification Condition

SAVe < —

10. Once Save has been clicked, a success message will appear.

Selection Contacts Conditions

Notification Rules have been configured successfully

11. If the default notification rules have been changed, the account will no longer have an asterisk (*).
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12. If the user would like to restore the default contact and conditions, they may do so by navigating to the
Contacts screen, where there will now be an option to select a checkbox to use default contact and
conditions.

Selection Conditions = Confirm

Enter the contact information to receive the ALERT

Cell Phone Text

Cell Phone 1 (555) 444-3333 Cell Phone 4

Cell Phone 2 (818) 209-9402 Cell Phone 5

Cell Phone 3 Cell Phone &
E-mail

Email 1 leralynn@client8.com Email 4

Email 2 miked@client8.com Email 5

Emall 3 Emaill &

Use Default Contact and Conditions <«
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Il. TRANSACTION HISTORY

PRO-TECH CR Transaction History allows authorized users to search and view all ACH credits that
have been received on enrolled accounts, and to make decisions on items. Client users can use
Transaction History to search for ACH transactions for a specific account using one of the many
filtering options available.

A. View Transaction History

NOTE:

» Transactions are available in transaction history for one (1) year.

» The Transaction History user privilege must be enabled to access this screen.

» If the user has been granted the Change Status user privilege and the transaction is available to
decision, the Pay and Return buttons will be available for use.

» Transactions that will be paid will have green shading as a background.

» Transactions that will be returned will have yellow shading as a background.

» Transaction in a return status cannot be changed after the EOD cut-off time.

1. There are two ways to navigate to the Transaction History page. One option is to navigate directly to
PRO-TECH CR Transaction History from the Dashboard, by clicking on any dollar amount displayed
within the PRO-TECH CR Dashboard. When using this option, Transaction History will only display
transactions included in the category selected. In the example below, the user would see only
transactions with a System Pay status. To see all transactions, click on Total ACH Credits.

End of Day Cut-Off Time: Friday 4:00 PM EST

Total ACH Credits $71,336.40 ©
Set to Pay $38,289.40 (25 ] Set to Return $33,047.00 (10

System $38,280,4() Qumm— [ 25 ] System $0.00 (0]

User $0.00 (0] User $47.00 [ 1]

FI $0.00 (0] F1 $0.00 (0]

Approved List $0.00 (0] Block List $33,000.00 (o]
Approved List Exceptions $71,336.40 €  Block List Returns $33,000.00 {5 ]

ACH ALE
Updated 4/15/2021 Page 68 of 97

an Alkami Solution Team



Another option is to navigate within the PRO-TECH CR module, to the View menu and click Transaction

History.

PRO-TECH CR Lk Setup - i Reports - i Transaction HIStory <« Change Module =
Welcome
Please use the above menu to select an action

2. The Transaction History page will display all current day transactions for all accounts to which the user

has access.
. ; . Date Range
Credit Transaction History ﬁwmbe?s Sii50
Y Filters >
Date Company Account # Amount Current Status Manage
» 11/06/2020 Olivia's Omelett 00001111 $3,200.00 Pay- System @ Reject
» 11/06/2020 Olivia's Omelett o111 $3,200.00 Pay- System
» 11/06/2020 Miveena's Natura w1111 $100.00 Pay - System
3 11/086/2020 Niveena's Natura oo 111 $100.00  Pay-System
$ 11/06/2020 Marshall Modelin o001 111 $47.00 Pay- System
» 11/06/2020 wmarshall Modelin 001111 $47.00  Return - User
» 11/06/2020 Leningrad Livery ool 111 $2,800.00 Pay- System
Date Date the ACH credit was presented or loaded to PRO-TECH CR.
Company Name of the company crediting the account. This information is obtained from the company name

field in the batch header record of the ACH transaction.

Account Number Account number the ACH credit was presented against.

Amount Amount of the ACH credit.

Current Status Status Description Change Allowed Until
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Manage

an Alkami Solution Tea

Pay

Return

Pay-System

Pay-User

Approved List-
Pay

Return-System

Return-User

Block List-
Return

Transactions that load with this status
indicate the default condition
established by the financial institution
is to pay all transactions on this
account if client users take no action.

Indicates a client user has changed the
status of a transaction from Return to
Pay.

Transactions that load with this status
indicate the company that originated
the transaction was set up on the
approved list for this account prior to
receipt of the transaction and the
transaction amount, frequency and
date are within the allowable
parameters specified in the approved
list entry.

Transactions that load with this status
indicate the default condition
established by the financial institution
is to return all transactions on this
account if client users take no action.

Indicates a client user has changed the
status of a transaction from Pay to
Return.

Transactions that load with this status
indicate the company that originated
the transaction was set up on the
blocked list for this account prior to
receipt of the transaction.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Return deadline, which
varies by financial
institution, account type
and transaction type.

Up until EOD cut-off time.

Up until EOD cut-off time.

Up until EOD cut-off time.

If the user has been granted the Change Status user privilege and the transaction is eligible for a
decision, an Accept or Reject button will appear for use. If the transaction is not eligible for a
decision, (because the return deadline or end of day cut-off time has passed) the button will
display as ineligible.
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a. To filter the date range of items shown, click on the Date Range drop-down.

Credit Transaction History

Y Filters

Date Company

» 11/06/2020 Olivia's Omelett

Olivia's Omelett

¥ 11/06/2020

35 transactions totaling $71,326.40

Rows 1 - 25 of 35.

Account # Amount

w1111

xxx1111

$3,200.00

$3,200.00

Current Status

Pay - System

Pay - System

Date Range
ENovember 6, 2020~

Tomormow
Yesterday
Last 7 Days
This Month
Last Month
Custom Range

ﬁ gance

e

b. To narrow the search results, click Filters and a window containing additional search criteria will

appear.

Credit Transaction History
Y Filters

Min Amount

$

Account’

- not selected -

W

Max Amount

5

Companies

Type a company name or id below

All companies shown

Transaction Status

Pay
Pay - System
Pay - User
Approved List Pay
Pay - FI

Return

Return - System
Return - User

Return - FI

Block List Return

Use the

"Ctrl" key

to select multiple status types

Date Range
ENovember 6, 2020~

b

Min Amount

amount of the transactions into the field.

Max Amount

amount of the transactions into the field.

Transaction
Status

Account

Companies

ACH ALE
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To search for a transaction by amount within a minimum/maximum range, type the minimum dollar

To search for a transaction by amount with a minimum/maximum range, type the maximum dollar

See #2 in this subsection for definitions of the different transaction statuses.

Type an account name or the last 4 digits of the account number into the field to view transactions
for one specific account or select an account from the drop-down menu.
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c. Once search criteria are selected, click Apply to narrow your search results.

d. Search results are displayed in pages of 25 items. If the search contains more than 25 issue items,
the results will be displayed on multiple pages. Use the navigation buttons at the top of the search
results to review all results.

T
1

{ transactions totaling 566,415,533

tows 1 - 25 of 20,

- :

e. Click the arrow (>) next to the Client Code to view more useful detail on each issued item. The
information shown in this drop-down is an audit history of all the activity that has occurred on the
issue item.

Date Company Account # Amount Current Status Manage

» 11/06/2020 Olivia’s Omelett 001111 $3,200.00  Pay - System ® Reject

v 11/06/2020 Olivia's Omelett xoox1111 $3,200.00 Return - User @ Accept

Account: WKP Main xo00¢1111 =EC Code: PPD Add to Approved List || Addto Block List
Transaction ID: 73124358 Description: PTTest0216 . .

Deadline To Pay: Friday 4:00 PM EST
Individual Mame: Olivia's Omelettes Trace #: 064208470001109

Company ID: 000008

v 11/06/2020 Miveena's Natura 001111 $100.00  Pay - System ® Reject
Account: 'WKP Main xo001111 SEC Code: PPD Add to Approved List || Add to Block List
Transaction ID: 73184855 Description: PTTest0815

Deadline To Return: Friday 4:00 PM EST
Individual Name: Miveena's Naturals Trace #: 064208470001107

Company ID: NOOODOS8

Account The account name and last 4 digits of the account number.

Transaction ID Unique ID assigned by the PRO-TECH CR system when transactions are loaded.

Individual Name Name of the payee/recipient found in the individual ID field of the incoming ACH
transaction.

SEC Code Standard entry class code. Reference the NACHA Rule Book for SEC code descriptions.

SEC codes are generally used to classify transactions by the way they were authorized.

Description The description used by the originator of the transaction, as contained in the company
batch header record for the transaction received.

ACH ALE Updtod 4/15/2021
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Trace # A unique ID assigned to the transaction by the originator, ACH operator or receiving
depository financial institution.

Company ID A unique identifier for the company that originated the ACH debit. This information is
obtained from the company ID field of the batch header record of the ACH transaction.
This unique identifier is used to match transactions to approved or blocked list entries.

Add to Approved List Will only appear if the user has Act on Approved list user privilege. Please refer to
Subsection lll, Approved List within this Section for more information about this
feature.

Add to Block List Will only appear if the user has Act on Blocked list user privilege. Please refer to
Subsection IV, Blocked List within this Section for more information about this
feature.

Deadline to Pay/Return Deadline to change the status of any transaction from Pay to Return or from Return to
Pay.

B. Change Transaction Status

1. If the user has been granted the Change Status user privilege and the transaction is eligible for a
decision, an Accept or Reject button will appear for use. If the transaction is not eligible for a decision, the
button will display as ineligible.

2. Change Status — Accept

a. If the Current Status on an issued item is set to Return, the Client can opt to change the status to Pay
if the Client determines the credit transaction should be paid.

b. Click the Accept button under the Manage column.

Date Company Account # Amount Current Status Manage

> 11/06/2020 Olivia's Omelett oo 111 $3,200.00 Pay - System ® Reject
> 11/06/2020 Olivia's Omelett 6001111 $3,200.00 Pay - System ® Reject
» 11/06/2020 Miveena's Matura o111 $100.00 Pay - System ® Reject
» 11/06/2020 Miveena's Matura 200061111 $100.00  Pay - System ® Reject
> 11/06/2020 Marshall Modelin xex1111 $47.00 Pay- System ® Reject
» 11/06/2020 Marshall Modelin oo 111 $47.00 Return - User @Accept  [B —

> 11/06/2020 Leningrad Livery xxxx1111 $2,800.00 Pay - System @ Reject
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c. A success message will appear temporarily in the Manage column, with an option to Add to Approved
List. This link will only appear if the user has the Act on Approved List user privilege. The user can
click the hyperlink embedded in that option to proceed to Add to Approved list. If the user does not
opt to Add to Approved list at this time, the option is still available under the expanded view of this

debit item.
Date Company Account # Amount Current Status Manage
> 11/08/2020 Olivia's Omelett 001111 $3,200.00 Pay - System ® Reject
» 11/06/2020 Clivia's Omelett 0001111 $3,200.00 Pay- User Credit will be paid.

# Add to Approved List

d. After a few moments, the Change Status button will then change to Reject, and the Current Status

column will update to “Pay-User.”

Date Company Account # Amount
> 11/06/2020 Olivia's Omelett o111 $3,200.00
> 11/06/2020 Olivia's Omelett o111 $3,200.00

Current Status

Pay - System

Pay - User

Manage

3. Change Status — Reject

a. If the Current Status on an issued item is set to Pay, the Client can opt to change the status to Return
if the Client determines the debit transaction should be returned.

b. Click the Reject button under the Manage column.

Date Company Account # Amount
3 11/06/2020 Olivia's Omelett 0001111 $3.200.00
> 11/06/2020 Clivia's Omelett 001111 $3,200.00
> 11/06/2020 Miveena's Matura 2001111 5100.00

Current Status

Pay - System

Pay - User

Pay - System

Manage

= —
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c. A success message will appear temporarily in the Manage column, with an option to Add to Block
List. This link will only appear if the user has the Act on Block List user privilege. The user can click
the hyperlink embedded in that option to proceed to Add to Block list. If the user does not opt to Add
to Block List at this time, the option is still available under the expanded view of this credit item.

Date Company Account # Amount Current Status Manage

» 11/06/2020 Clivia's Omelett 001111 $3,200.00 Return - User Credit will be returned
= Add to Block List

» 11/06/2020 Olivia's Omelett wox1111 $3,200.00  Pay - User @ Reject

d. The Change Status button will then change to Accept, and the Current Status column will update to
“Return-User.”

Date Company Account # Amount Current Status Manage

» 11/06/2020 Clivia's Omelett 0001111 $3,200.00 Return - User @ Accept

an Alkami Solution Team
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lll. APPROVED LIST

The Approved List allows Clients to identify companies that are allowed to credit an account or accounts and
set parameters to control the credit activity. There are multiple ways to populate the approved list. It can be
done through the Setup > Approved List menu option, or users can add companies to the approved list from
Transaction History. It is important to note that companies added from Transaction History will only be added
to the account associated with the transaction it was added on. To allow the company to credit other
accounts, the user must edit the approved list.

Users can edit and delete companies from their approved list.

The way PRO-TECH CR identifies approved companies is by verifying the company ID ONLY in the
batch header record of the incoming ACH transaction is an exact match. If an exact match is found, if
additional parameters have been established such as maximum amount, frequency, start/end date, the
values found in the ACH batch/transaction are compared to the list to determine if an alert is required and the
transaction status that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the approved list
is shown below.

Verifies Company ID

101 026013262 06420851820080605508094101DeLacre Bank & Trust  FRB Atlanta
52002shland Armament PEDETT=st0820 200806 1064208470000031
6220260132627677677678 0000150000200008 Ashland Armament 0064208470000393
6270260132627677677678 0000030000A00008 Ashland Armaments 0064208470000394
820000000200052026520000000300000000001 0008 064208470000031
5200Biclab Birmingha I B00008]  PPDPTTEest0805 200806 1064208470000032
6220260132627677677678 0000130000B0000E Biolab Birmingham 0064208470000355
6270260132627677677678 0000250000B00008 Biolab Birmingham 0064208470000396
820000000200052026520000002500000000001 0008 064208470000032
5200Cartwright Car S C00008 PPDPTTest0806 200806 1064208470000033
6220260132627677677678 0000800000C00008 Cartwright Car Sales 0064208470000397
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop D0000B PPDPTTest0804 200806 1064208470000034
6220260132627677677678 0000170000D00008 Del Aire Developers 0064208470000398
6270260132627677677678 0000270000D00008 Del Aire Developers 0064208470000359
82000000020005202652000000270000000000170000D00008 064208470000034

Compares against Maximum Amount Parameter

101 026013262 06420851820080605502094101Delacre Bank & Trust FRE ZAtlanta

5200ashland Armament 200008 PPDPTTest0820 200806 1064208470000031
6220260132627677677678 0000150000400008 Zshland Armamsnt 0064208470000353
6270260132627677677678 00000300004200008 Zshland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000A00008 064208470000031
5200Biolab Birmingha BOOOOS PPDPTTest08B05 200806 1064208470000032
6220260132627677677678 C000130000p00008 Biolabk Birmingham 0064208470000355
6270260132627677677678 00o0250000p00008 Biolak Birmingham 006420847000035%6
82000000020005202652000000250000000000130000B00008 064208470000032
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Compares aqgainst Frequency and Start/End Date Parameters

101 026013262 064208518200806095000594101Deliacre Bank & Trust FEB Atlanta

52004a=shland Armament 00008 PPDPTT=st0820 200806 1064208470000031
6220260132627677677678 0000150000200008 Ashland Armamel 0064208470000353
6270260132627677677678 0000030000200008 Ashland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000200008 0€4208470000031
5200Biolab Birmingha BQOOODS8 PPDPTTest0802 1064208470000032
6220260132627677677678 0000130000B00008 Biolak Birmingham 0064208470000355
6270260132627677677678 0000250000B000D0B Biolab Birmingham 0064208470000356
820000000200052026520000002500000000001320000B00008 064208470000032

If the notification criteria is set to Notify when a credit comes in from a company not on the approved list or
violates approved list parameters, PRO-TECH CR will alert designated contacts when a credit is received
from an unknown company or from a company that is set up, but violated the parameters. If notification
criteria are set to all credits, credits over a certain amount or certain types of credits, the system will NOT
alert for approved list violations. If the transaction meets approved list criteria, it will receive a status of
Approved List-Pay. If it does not, it will receive the system default status.

A. Add to Approved List From Setup Menu

NOTE:

» Acton Approved List user privilege required.

1. Within the PRO-TECH CR module, click Setup > Approved List.

PRO-TECH CR L setup - Wi Reports ~ iZ Transaction History Change Module -

Notification Rules

—
Welc Block List

Please use the above menu to select an action
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2. The Credit Approved List will display. Click the Create button to add an entry to the Approved List.

+ Create <G
Company ID &

Delete

(] ADODO8

@ Delete Selected

Ashland Armament

Company Name +
Maximum Amount

$12,000.00

Approved List

Frequency

Start Date

08/05/2020

End Date Edit

Edit

@ Cancel

3. The Add Company page will display. Complete all applicable fields in the top section of the screen.

Approved Company
Company Detail
Company ID Company Name
Max Amount Frequency No Frequency -
Start Date 08/05/2020 End Date
Add Accounts to Approved List
CPP767Test1 - xoxx7677
Client 8 Expense - xxxx7679
Client 8 Main - :0xx7678
~ Save @ (Cancel
Field Name Optional or Field Validated Field Content Notes
Required
Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
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Field Name Optional or | Field Validated Field Content Notes
Required
Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)
Max Amount Optional The transaction meets e Blank: Any amount  Valid Characters:
the parameters when is accepted and will | 0-9
the amount the amount not trigger an alert.
is less than or equal to o Zero: Will not be
the Max Amount accepted and entry
The transaction does will not save to
not meet the Approved List.
parameters when the e Highest amount:
amount is greater than $99,999,999.99
the Max Amount.
Frequency Optional If multiple transactions | ¢ Daily: 1 business Counter:
are on a file, the sort day
order is highest to e Weekly: 7 calendar | The counter begins with
lowest dollar value. days the first transaction
If the transaction with e Bi-Weekly: 14 received after the
the highest dollar value calendar days Company and Account is
exceeds the Maximum |« Monthly: Monthly added to the Approved
Amount, all transactions date-to-date List regardless if the
on the file are not e Quarterly: Quarterly transaction meets or does
approved. date-to-date not meet the parameters
If the transaction with o Yearly: Yearly date- = ©f the Approved List.
the highest dollar value to-date
is equal to or less than
the Maximum Amount, | Date-to-Date
that transaction is Exceptions:
approved and all other | ¢ Non-Leap Year
transactions on the file January 29, 30, 31:
are not approved. February 28
e lLeap Year January
30, 31, February 29
e March 31: April 30
e May 31: June 30
e August 31:
September 30
e October 31:
November 30
Start Date Required The transaction meets  The Start Date is Valid Characters:

the parameters when
the date is equal to or
after the Start Date.
The transaction does
not meet the
parameters when the
date is before the Start
Date.

based on the
settlement date.

0-9
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Field Name Optional or | Field Validated Field Content Notes
Required
End Date Optional e The transaction meets The End Date is Valid Characters:

the parameters when
the date is equal to or
before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

based on the
settlement date.

0-9

4. Choose from the list of available accounts to add to the Approved List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Approved List

CPP767Test1 - 20xx7677

Client 8 Main - 007678 =

Yl

~ Save

Client 8 Expense - xxxx7679

@ Cancel

5. Once the entry is completed, click Save to save it to the Approved List. A success message will appear.

Approved Company Saved Successfully

+ Create
Approved List
CompanyID ¢ Company Name ¢
Delete Maximum Amount Frequency Start Date End Date Edit
O AD0008 Ashland Armament $12,000.00 08/05/2020 Edit
O H00008 Hats on Heart St $5,000.00 08/05/2020 Edit
@ Delete Selected @ Cancel
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6. To edit any entity on the Approved List, click the Edit hyperlink at the end of the appropriate row to be

taken to the Company’s screen.

7. To delete any entity on the Approved list, click the checkbox next to the appropriate row, and click the

Delete Selected button.

B. Add to Approved List from Transaction History

NOTE:

» Transaction History user privilege required.
» Act on Approved List user privilege required.

1. From the Transaction History page, click the > arrow to expand the entry of the ACH credit transaction.

Account: Client 8 Main xxxx7678
Transaction ID: 73179180

Individual Name: Leningrad Livery

SEG Code: PPD
Description: PTTest0813
Trace #: 064208470000433

Company 1D: LOO0O8

Date Company Account # Amount Current Status
> 08/07/2020 Marshall Modelin XXXX7678 $47.00 Pay- System
v 08/07/2020 Leningrad Livery XXHXTB78 $2,800.00 Pay - System

Add to Approved List

Deadline To Return: Friday 4:00 PM EDT

Manage

Add o Block List

2. Click the Add to Approved List button to add a company. The Add Company pop-up window will appear.

Add Company to Approved List
Company Id Company Name Start Date End Date
LO0D08 Leningrad Livery & | 08/07/2020 =
Max Amount Frequency
2800 - none — hd
Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header
record of the transaction received.
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Field Description Can Be Modified
Company Name Populated with the company name data from the batch header v

record of the transaction received.
Max Amount Populated with amount of transaction received. v
Frequency Left blank. v
Start Date Populated with the date of transaction received. v
End Date Left blank v

3. Click the Save button to add to Approved List. Click Cancel to return to the Transaction History without
adding to the Approved List.

4. The user will be directed to the Transaction History page once the company has been added to the
Approved List.
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C. Approved List Failure Reasons

When a transaction exception is triggered because of Approved List parameters, the system default status
will apply. Examples of types of failure reasons are listed below.

Reason Description Sample
Transaction Dollar amount of transaction is
. . . Current Status Manage
Amount is greater than the maximum amount in
Greater than the Approved List entry. Pay - System
Approved List
Amount Add to Approved List Add to Block List
Deadline To Return: 08/16/2020 5:00 PM EDT
Approved List Violation: Transaction Amount: 1500 is greater than Approved
List amount: 1000
Frequency Transaction violates the frequency set
Failure in the Approved List entry. Pay - System
Add to Approved List Add to Block List
Deadline To Return: 10/03/2020 4:00 PM EDT
Approved List Violation: Frequency: YEARLY Last Transaction Date:
06-AUG-20
Out of Date Transaction was presented prior to
Range the Start Date or after the Ending Pay - System
Date of the Approved List entry.
Add to Approved List Add to Block List
Deadline To Return: 08/13/2020 5:00 PM EDT
Approved List Violation: Out of Date range - Start Date: 18-JUN-20 End Date:
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IV. BLOCK LIST

The Block List is an optional feature which, if enabled by the Fl, allows Clients to identify companies that are
NOT allowed to debit an account or accounts. There are multiple ways to populate the block list. It can be
done through the Setup > Approved List menu option, or users can add companies to the block list from
Transaction History. It is important to note that companies added from Transaction History will only be added
to the account associated with the transaction it was added on. To prevent the company from debiting other
accounts, the user must edit the block list.

Users can edit and delete companies from their block list.

If an exact match is found, if additional parameters have been established such as frequency, start/end date,
the values found in the ACH batch/transaction are compared to the list to determine if an alert is required and
the transaction status that should be applied at load time.

Some examples of incoming ACH files and the data elements used for comparison against the blocked list is
shown below.

Verifies Company ID

101 026013262 0642085182008060550205410 DT a= Bank & Trust FREB Atlanta

3200&shland Armament PPDPTTest0820 200808 1064208470000031
6220260132627677677678 00001530000200008 Ashland Armament 0064208470000353
6270260132627677677678 0000030000200008 Ashland Armaments 00€4208470000354
820000000200052026520000000300000000001 0008 0€4208470000031
5200Biclab Birmingha BOOOOS PPDPTTest0805 200806 1064208470000032
6220260132627677677678 0000130000B00008 Biolab Birmingham 0064208470000355
6270260132627677677678 0000250000B0O0O0OO0B Biolab Birmingham 0064208470000356
82000000020005202652000000250000000000120000R00008 064208470000032
5200Cartwright Car 3 c00008 PPDPTTest0806 200806 1064208470000033
6220260132627677677678 0000800000C0D008 Cartwright Car Sales 0064208470000357
82000000010002601326000000000000000000800000C00008 064208470000033
5200Del Aire Develop Dooo0s PPDPTTest0804 200806 1064208470000034
6220260132627677677678 0000170000D0O00OO0B Del Rire Developers 0064208470000358
6270260132627677677678 0Q00270000D0O000B Del Rire Developers 00&4208470000355
82000000020005202652000000270000000000170000D00008 064208470000034

Compares aqgainst Frequency and Start/End Date Parameters

101 026013262 06420851820080609500094101Deliacre Bank & Trust FEE Atlanta

5200ashland Armament &00008 PPDPTTest0820 200806 1064208470000031
6220260132627677677678 0000150000200008 Ashland Armamerl 0064208470000353
6270260132627677677678 0000030000200008 ZAshland Armamsnts 0064208470000354
82000000020005202652000000030000000000150000200008 064208470000031
5200Bioclab Birmingha BOOOOS PPDPTT=st0805 1064208470000032
6220260132627677677678 0000130000B00008 Eiclak Birmingham 0064208470000355
6270260132627677677678 0000250000B0000B Eiclak Birmingham 00&4208470000356
82000000020005202652000000250000000000130000B00008 064208470000032
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Blocks are intended to automatically return items and alerts are not sent out. However, Clients can see those
items in transaction history and have the option to pay them before EOD cut-off time. The dashboard will be
updated in the next release to display blocked item summary information.

A. Add to Block List From Setup Menu

NOTE:

» Act on Blocked List user privilege required.

1. Within the PRO-TECH module, click Setup > Block List.

PRO-TECH £ setup - i Reports - & Transaction History Change Module -

Notification Rules
Approved List
\[ Block List B ]

Please use the above menu to select an action

2. The Credit Block List will display. Click the Create button to add an entry to the Block List.

+ Create @
Block List
Company ID ¢ Company Name %
Delete Start Date End Date Edit
O SKETCH Sketchy Corp 06/19/2020 Edit
@ Delete Selected @ Cancel
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3. The Add Company to Debit Block List page will display. Complete all applicable fields in the top
section of the screen.

Blocked Company

Company Detail

Company ID Company Name

Start Date 06/19/2020 End Date

Add Accounts to Block List

FFF Escrow - xoxood444
FFF Expense - xxxx3333
FFF Payroll - xxxx2222
FFFriends -x000(1111

1

~ Save @ Cancel

Field Name Optional or Field Validated Field Content Notes
Required

Company ID Required Exact Match Max: 10 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

Company Name | Optional Not Validated Max: 16 Valid Characters:
A-Z
a-z
# (number sign)
0-9
, (comma)
- (dash)
(space)
_ (underscore)

an Alkami Solution Team
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Field Name Optional or | Field Validated Field Content Notes

Required
Start Date Required e The transaction meets The Start Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.
after the Start Date.
e The transaction does
not meet the
parameters when the
date is before the Start
Date.
End Date Optional e The transaction meets The End Date is Valid Characters:
the parameters when based on the 0-9
the date is equal to or settlement date.

before the End Date.

e The transaction does
not meet the
parameters when the
date is after the End
Date.

e The transaction meets
the parameters when
the field is blank.

4. Choose from the list of available accounts to add to the Block List.

> and < move individual accounts between list of available accounts and selected accounts.
>> and << move all accounts between the available and selected accounts fields.

Add Accounts to Block List

FFF Expense - 00003333 ] FFF Escrow - xxd444

FFF Payroll - xxxx2222
FrFriends - xox1111

=1

~ Save @ Cancel
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5. Once the entry is completed, click Save to save it to the Block List. A success message will appear.

Blocked Company Saved Successfully
+ Create
Block List
Company ID ¢ Company Name $

Delete Start Date End Date Edit
|| MAX Maximum Focus 06/19/2020 Edit
O SKETCH Sketchy Corp 06/19/2020 Edit

@ Delete Selected @ Cancel

6. To edit any entity on the Block List, click the Edit hyperlink at the end of the appropriate row to be taken
to the Company’s screen.

7. To delete any entity on the Block list, click the checkbox next to the appropriate row, and click the Delete
Selected button.

B. Add to Block List from Transaction History

NOTE:

» Transaction History user privilege required.
> Act on Block List user privilege required.

1. From the Transaction History page, click the > arrow to expand the entry of the ACH debit transaction.

Date Company Account # Amount Current Status Manage
» 11/06/2020 Olivia's Omelett xox1111 $3,200.00 Return - User @ Accept
v 11/06/2020 Olivia's Omelett oo 111 $3,200.00 Pay- User ® Reject
Account: WKP Main xoooc1 111 2EC Code: PPD Add to Approved List || Add to Block List
Transaction ID: 73184858 Description: PTTest0216 ; 3 L
Deadline To Return: Friday 4:00 PM EST
Individual Name: Olivia's Omelettes Trace #: 064208470001109

Company ID: 000008
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2. Click the Add to Block List to add a company. The Add Company pop-up window will appear.

Add Company to Block List
Company Id Company Name Start Date End Date
MO0008 Marshall Modelin B 08/07/2020 =
Field Description Can Be Modified
Company ID Populated with the company ID data from the batch header

record of the transaction received.

Company Name

Start Date

Populated with the company name data from the batch header v
record of the transaction received.
Populated with the date the transaction was received.

<

End Date

Left blank

3. Click the Save button to add to Block List. Click Cancel to return to the Transaction History without adding
to the Block List.

4. The user will be directed to the Transaction History page once the company has been added to the Block

List.

C. Block List Failure Reasons

When a transaction exception is triggered because of Block List parameters, the system default status will
apply. Examples of types of failure reasons are listed below.

Reason Description Sample
Out of Date Transaction was presented prior to the
Range Start Date or after the Ending Date of Block List Return
the Approved List entry.
Add to Approved List Add to Block List

ACH ALE
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V. REPORTS

NOTE:
> Reports are available for one (1) year.

A. Notification Rules Report

The Notification Rules report provides authorized Client users a method to view the notification conditions set
for each account enrolled for the service. The report allows users to see the default account setting
established by the financial institution, as well as the notification condition and contact information
established by the Client.

1. Within the PRO-TECH Module, click Reports > Notification Rules Report.

PRO-TECH ¥ Setup ~ o1 Reports ~ iE Transaction History Change Module ~

Approved List
Block List

WE| CO ][ Notification Rules Report ]4—

Please use the above menu to select an action
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2. The Notification Rules Report page appears.

Notification Conditions for Client 3
Account Number Accoru mt Not\ﬂ;a(ion Amount Check Internet Phone Email Cellphone
Setting Condition
1. mhart@fffriends.com 1. 5554443333
2. fjones@fffriends.com 2. 8182099402
: f 3. 3
oxx1111 Pay All All Debits i 5
5. 5
6. 6.
1. mhart@fffriends.com 1.5554443333
2. fijones@fffriends.com 2.8182099402
KXXX2222 Pay All All Debits i _31
50 5.
6. 6.
1. mhart@fffriends.com 1. 5554443333
2. fiones@fffriends.com 2.8182099402
Xxx3333 Pay All All Debits j i
5. 5
6. 6
1. mhart@fffriends.com 1.5554443333
2. fjones@fffriends.com 2. 8182099402
w44 Pay All All Debits i _31
50 5
6. 6
Total count: 4
Account Number The last 4 digits of each account number enrolled.
Account Setting The default pay or return setting established by the financial institution when the account
was enrolled for the service.
e Pay All
e Return All
Notification Condition See Notification Rules section for detailed descriptions:
¢ All Debits

e Debit Over the Debit Amount
e Company Not in Approved List

Debit Amount If Notification Condition is Debit Over the Debit Amount, the amount entered will be
displayed.
Check ¢ If Notification Condition is ACH Debits with Check/Internet/Phone is selected

If Check is selected, Y will be displayed.

Internet o If Notification Condition is ACH Debits with Check/Internet/Phone is selected
e If Internet is selected, Y will be displayed.
Phone o If Notification Condition is ACH Debits with Check/Internet/Phone is selected
e If Phone is selected, Y will be displayed.
Email Email address(es) that will receive email alerts.
Cell Phone Cell phone number(s) that will receive email alerts; this section will display only if the

financial institution is configured to allow SMS Text alerts.
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B. Approved List Report

NOTE:

» Approved List Report user privilege required.

The Approved List report makes it easy for Client users to identify all the companies set up on the approved
list for a specific account.

1. Within the PRO-TECH Module, click Reports > Approved List.

PRO-TECH ¥ Setup ~ i Reports ~ iE Transaction History Change Module =
[ Approved List G
Block List

We | COl (otification Rules Report

Please use the above menu to select an action

2. The Approved List Report page appears.

Approved List
Account: - All - -
Search Cancel
Approved List
Company ID & Company Name & Maximum Amount & Frequency < Start Date ¢ End Date & Action
ACME Acme Widget $20,000.00 = YEARLY 06/18/2020 View

3. The Account drop-down menu will allow the user to search approved list entries by account number.
Select the account number from the drop-down menu. Click the Search button to proceed.

Approved List

Account: [_ Al - I vl

- All-
FFFriends - xoox1111
FFF Payroll - xxxx2222
FFF Expense - Xxxx3333
FFF Escrow - 004444 Approved List
Company ID ¢ Company Name & Maximum Amount < Frequency ¢ Start Date & End Date & Action

wearch Cancel
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4. All Approved List entries for that account number will be displayed.

Approved List

Account:

Company ID &
ACME
CANOVA
CLEARY
RICHARDS
TJONES1

Company Name Maximum Amount Frequency < Start Date & End Date & Action

. Acme Widget . $20,000.00 = YEARLY . 06/18/2020 View
Richard Canova $10,000.00 DAILY 06/19/2020 View
Frank Cleary $1,000.00 WEEKLY 06/19/2020 View
Richards & Assoc $10,000.00 MONTHLY 06/19/2020 07/19/2020 View
Tom Jones $50,000.00  MONTHLY 06/18/2020 View

FFFriends - 20001111 =

Search Cancel

Approved List

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH
welcome screen.

6. The user
column.

may view Approved List details for any company by clicking the View hyperlink in the Action

Approved List

Account:

CompanyID ¢
ACME
CANOVA

Company Name % Maximum Amount & Frequency % Start Date ¢ End Date ¢ Action
Acme Widget $20,000.00 = YEARLY 06/18/2020 View < m—
Richard Canova $10.000.00 = DAILY 06/19/2020 View

FFFriends - 21111 b

Search Cancel

Approved List

7. The Approved List Details screen will display company detail, including all accounts included on the
Approved List. Click the Back button to return to the Approved List Report screen

Company Detail

Company ID
Max Amount
Start Date

Accounts

ACME Company Name Acme Widget
$20,000.00 Frequency YEARLY
06/18/2020 End Date

FFFriends - xxxx1111
FFF Payroll - xo0x2222
FFF Expense - xxxx3333
FFF Escrow - xooud444

Back
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C. Block List Report

NOTE:

» Block List Report user privilege required.

The Block List report makes it easy for Client users to identify all the companies set up on the block list for a
specific account.

1. Within the PRO-TECH CR Module, click Reports > Block List.

PRO-TECH CR £ Setup ~ i Reports ~ i= Transaction History Change Module ~

Approved List
| Block List |

We | COIM notification Rules Report

Please use the above menu to select an action

2. The Block List Report page appears.

Block List
Account: - All - -
Search Cancel
Block List
Company ID & Company Name & Start Date & End Date & Action
MAX Maximum Focus 06/20/2020 View

3. The Account drop-down menu will allow the user to search approved list entries by account number.
Select the account number from the drop-down menu. Click the Search button to proceed.

Block List

Account: [-AII . [ -]
- All-
FFFriends - xoocx1111 g2sh gaoed
FFF Payroll - xo0m2222
FFF Expense - xxxx3333
FFF Escrow - xxxx4444 Block List

Company ID & Company Name & Start Date & End Date ¢ Action
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4. All Block List entries for that account number will be displayed.

Block List
Account: FFFriends - xooxx1111 o
Search Cancel
Block List
Company ID < Company Name Start Date ¢ End Date & Action
A03 Armada Resources 06/19/2020 View
DD1 Dogwood Designs 06/19/2020 View
MAX Maximum Focus 06/20/2020 View
SKETCH Sketchy Corp 06/19/2020 View

5. Clicking the Cancel button at any time on this screen will navigate the user back to the PRO-TECH CR
welcome screen.

6. The user may view Block List details for any company by clicking the View hyperlink in the Action column.

Block List
Account: FFFriends - xox1111 =
Search Cancel
Block List
CompanyID ¢ Company Name & Start Date ¢ End Date & Action
A03 Armada Resources 06/19/2020 View - um—
DD1 Dogwood Designs 06/19/2020 View

7. The Block List Details screen will display company detail, including all accounts included on the Block
List. Click the Back button to return to the Block List Report screen.

Company Detail

Company ID AD3 Company Name Armada Resources
Start Date 06/19/2020 End Date
Accounts

* FFFriends - xox 1111

* FFF Payroll - 0002222
* FFF Expense - 003333
* FFF Escrow - 000444

Back < m—
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APPENDIX A — MESSAGE ALERTS

Service Alert Type Description Recipient
Module
PRO-TECH & Debit Notification Account Account Debit Notification Client
PRO-TECH
CR
Credit Notification Account Account Credit Notification Client
Debit Notification Transaction Debit Transaction Notification Client
Credit Notification Transaction Credit Transaction Notification Client
Debit Service Alert Debit Service Alert Client
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APPENDIX B — DOCUMENT REVISION INDEX

A comprehensive list of all revisions made to this document since last publication.

Previous Version: 1.0.3 (published 03/15/2021)
Current Version: 1.0.4. (published 04/15/2021)

Section Pages Description

Entire Document Miscellaneous screenshots updated to reflect minor
changes in user interface.

Section A — IV — User Accounts and p. 20 Updated Notification Rules user permission to note that

Privileges this privilege will not appear unless the Client Manage
Notify Rules permission is enabled by the FI.

Section B — | — Notification Rules p. 23 NOTE box: Added that the Notification Rules functionality
will not appear unless the Client Manage Notify Rules
permission is enabled by the FI.

Section B - Il - Transaction History p. 35 Noted that a copy of the Transaction History can be
downloaded in .csv format.

Section B — IV — Blocked List p.- 51 Correction on which Block List parameters that
transactions are compared to.

Section C — | — Notification Rules p. 63 NOTE box: Added that the Notification Rules functionality
will not be available unless the Fl enables the Client
Manage Notify Rules permission.

Section C — Il - Transaction History p. 75 Noted that a copy of the Transaction History can be
downloaded in .csv format.

Section C - IV — Blocked List p. 88 Correction on which Block List parameters that
transactions are compared to.
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